Thank you for purchasing FUJIFILM Science Lab 2001 Image Gauge. Before using this software, please be aware of the following important items.

Regarding the use of Science Lab 2001 Image Gauge software:
When you first started using this software, you agreed to the usage conditions specified below, and Fuji Photo Film Co., Ltd. granted you a license to use the Science Lab 2001 Image Gauge software.
The ownership rights to the software belong to Fuji Photo Film Co., Ltd. and Kohshin Graphics Systems Inc. In keeping, this software is not something that is sold to you but something that Fuji Photo Film Co., Ltd. grants you a license to use. The recording media is yours, but the ownership rights to the software remain with Fuji Photo Film Co., Ltd.

LICENSE TERMS
1) You are granted the use of Science Lab 2001 Image Gauge software for a single CPU or a single unit within multiple CPUs. Hence, in a computer network environment, a separate Science Lab 2001 Image Gauge software license will be required for each unit that will be using the software.
2) You are allowed to copy Science Lab 2001 Image Gauge software onto different media for backup and program execution purposes.

USAGE LIMITATION
1) No copying, modification or transfer of Science Lab 2001 Image Gauge software other than specified by the terms of the usage license is allowed.
2) No reverse compiling or reverse assembling of Science Lab 2001 Image Gauge software done for the purpose of turning Science Lab 2001 Image Gauge software into a readable format is allowed.
3) No lending or distribution of Science Lab 2001 Image Gauge software or a part thereof for profit is allowed.
4) No derivative copyrighted product can be produced from Science Lab 2001 Image Gauge software, or modifications of it, or in conjunction with other software.

NOTES
1) Reproduction of parts or all of the contents of this manual without permission is prohibited.
2) The contents of this manual are subject to change without notice.
3) This manual has been prepared with utmost care. However, if you have any questions or find errors, omissions, etc., please contact us.
4) We will not be liable for any effects incurred from the use of this device.

Copyright Reserved
<Reprint and/or reproduction of parts or whole of this manual is prohibited.>

Copyright© 1998-1999 by Fuji Photo Film Co., Ltd.

Apple logo is a registered trademark of Apple Computer, Inc. Canvas™ is a registered trademark of Deneba Co., Ltd. Excel is a registered trademark of Microsoft Co., Ltd. Macintosh, Quick Time, and Geneva are registered trademarks of Apple Computer, Inc. Adobe Photoshop is a registered trademark of Adobe Systems Co., Ltd. in the U.S. All other company names and product names mentioned here in are the trademarks or registered trademarks of their respective owners.
1 "Portions of this product are copyright ©1991-1997 Altura Software Inc. All rights reserved."

2 "COMPANY'S LICENSOR (S) MAKES NO WARRANTIES, EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, REGARDING THE SOFTWARE. COMPANY'S LICENSOR (S) DOES NOT WARRANT, GUARANTY, OR MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF THE USE OF THE SOFTWARE IN TERMS OF ITS CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE SOFTWARE IS ASSUMED BY YOU. THE EXCLUSION OF THE IMPLIED WARRANTIES IS NOT PERMITTED BY SOME STATES. THE ABOVE EXCLUSION MAY NOT APPLY TO YOU."

3 "IN NO EVENT WILL COMPANY'S LICENSOR (S), AND THEIR DIRECTORS, OFFICERS, EMPLOYEES, OR AGENTS (COLLECTIVELY "COMPANY'S LICENSOR") BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, INCIDENTAL, OR INDIRECT DAMAGES (INCLUDING DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, AND THE LIKE) ARISING OUT OF THE USE OF, OR INABILITY TO USE, THE SOFTWARE EVEN IF COMPANY'S LICENSOR HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU."
This equipment cannot be taken to or used in a country or area where power supply specifications differ from those in the country or area where it was originally installed.

**JAPAN**

This device is in compliance with the VCCI standards established by the conference on self-imposed control of noise interference caused by information devices for the purpose of preventing interference in commercial and industrial areas caused by Class 1 information devices (information devices to be used in commercial and industrial areas). If this device is used in residential areas adjacent to them, it may cause radio disturbance. This device must be handled correctly in accordance with this operation manual.

**United States of America**

This equipment generates, uses, and can radiate radio frequency energy and if not installed and used in accordance with the instructions manual, may cause interference to radio communications. It has been tested and found to comply with the limits for a Class A computing device pursuant to Subpart J of part 15 of FCC Rules, which are designed to provide reasonable protection against such interference when operated in a commercial environment. Operation of this equipment in a residential area is likely to cause interference in which case the user at his own expense will be required to take whatever measures may be required to correct the interference.

**Canada**

This digital apparatus does not exceed the Class A limits for radio noise emission from digital apparatus as set out in the radio interference regulations of the Canadian Department of Communications.

“Le présent appareil numérique n’émet pas de bruits radioélectriques cépassant les limites applicable aux appareils numériques de la class A prescrites dans le Règlement sur le brouillage radioélectrique édicté par le ministère des Communications du Canada.”
Contents

Part A Before Beginning Operations
1. Image Gauge Ver. 4.0 ......................................................................................................... A-2
2. System Configuration ..................................................................................................... A-3
3. Installing Image Gauge Ver. 4.0 ........................................................................................ A-4
4. Image Gauge Ver. 4.0 Operating Environment ............................................................. A-5

Part B Viewing an Image
1. Starting Up and Quitting this Software ........................................................................ B-2
   Starting Up .................................................................................................................... B-2
   Quitting ....................................................................................................................... B-3
2. Image Gauge Menu Lists ............................................................................................... B-4
   File menu ...................................................................................................................... B-4
   Edit menu ..................................................................................................................... B-5
   Image menu ................................................................................................................ B-5
   Analysis menu .............................................................................................................. B-6
   Windows menu .......................................................................................................... B-7
   Applications menu ..................................................................................................... B-7
3. Viewing an Image ........................................................................................................ B-8
   3.1 Image Reading ....................................................................................................... B-8
   3.2 Opening an Image File ........................................................................................... B-8
   3.3 Trimming an Image ............................................................................................... B-10
   3.4 Dividing and Saving an Image ............................................................................... B-14
4. Names of the Parts of the Image Gauge Window .......................................................... B-15
5. Changing the Monitor Display ....................................................................................... B-16
   5.1 Changing the Display Color .................................................................................. B-16
   5.2 Adjusting Contrast ............................................................................................... B-16
   5.3 Enhancing Contrast ............................................................................................ B-27
   5.4 Display an Entire Image ...................................................................................... B-29
   5.5 Displaying Informations Related to Image ......................................................... B-30

Part C Quantifying an Image
1. Four Analysis Modes .................................................................................................... C-2
2. Using the Analysis Tools .............................................................................................. C-3
   2.1 Analysis Tools Common to Each Mode ............................................................... C-3
      Pointer Tool ............................................................................................................. C-3
      Density Picker Tool ............................................................................................... C-5
      Magnifying Glass Tool ......................................................................................... C-7
      Hand Tool .............................................................................................................. C-9
2.2 Annotation Mode ............................................................................................................. C-10
   Image Selector tool ................................................................. C-10
   Text Tool ................................................................. C-13
   Arrow Tool ................................................................. C-15
   Info Stamp Tool ............................................................. C-16
   Scale Bar Tool ................................................................. C-18
   PICT Stamp Tool ............................................................... C-19
   Menu Functions Related to Annotation ........................................... C-21
2.3 Quant Mode .................................................................................................................. C-23
   Rectangle Tool ................................................................. C-23
   Freehand Tool ................................................................. C-24
   Polygon Tool ................................................................. C-26
   Oval Tool ................................................................. C-28
   Slanted Rectangle Tool .......................................................... C-29
   Ladder Tool ................................................................. C-30
   Matrix Tool ................................................................. C-33
   Free-Division Matrix Tool .................................................. C-36
   Automatic Band Tool .......................................................... C-39
   Correcting a Ladder/Freehand Matrix .......................................... C-42
   Titer Plate Tool ................................................................. C-43
   Magic Wands Tool .............................................................. C-45
   Free Edit Tool ................................................................. C-47
   Menu Functions Related to Quant ................................................... C-48
   Making an ROI Data File ......................................................... C-48
   Using Duplicate ...................................................................... C-50
   Saving Quantification Areas .................................................... C-52
   Retrieving the Saved Quantification Areas .................................. C-53
   Displaying Quant Results ......................................................... C-55
2.4 Profile/MW Mode ........................................................................................................... C-56
   Line Profile Tool ................................................................. C-56
   Lane Profile Tool ............................................................... C-57
   Smile Lane Profile Tool ......................................................... C-58
   Start Line Tool ................................................................. C-60
   Automatic Lane/Band Tool ...................................................... C-62
   Band Tool ................................................................. C-65
   Menu Functions Related to Profile/MW ........................................... C-66
   Deleting Lane ....................................................................... C-66
   Setting Lane Width ............................................................... C-67
   Setting the Peak ROI Type ....................................................... C-68
   Peak Aid Function ............................................................... C-69
   Saving the Lane ................................................................. C-71
Contents

Retrieving the Saved Lane ................................................................. C-72
Displaying Profiles .............................................................................. C-74
2.5 Distance Mode ............................................................................... C-75
  - Distance Tool ............................................................................... C-75
  - Interval Tool ............................................................................... C-77
  - Angle Tool .................................................................................. C-79

Part D Analyzing Quantification Results

1. Analysis in Quant Mode ................................................................. D-2
   Selection of Displayed Items .......................................................... D-2
   Dividing Measured Regions into Groups ........................................ D-4
   Quant Result Operations ............................................................... D-7
     (1) Background Subtraction ......................................................... D-7
       (1)-1 When there is no group division ........................................ D-7
       (1)-2 When there is group division ........................................... D-8
     (2) Setting a Standard ............................................................... D-10
       (2)-1 Setting a Standard when there is no group division ........ D-10
       (2)-2 Setting a Standard for Each Group ............................... D-12
     (3) Shortcuts for Setting Groups, Backgrounds, and Standards .... D-13
     (4) Setting Reference Values .................................................... D-14
     (5) Setting the Calibration Curve ............................................. D-15

2. Analysis in Profile/MW Mode ......................................................... D-20
   Displaying the Profile Line .......................................................... D-20
   2.1 Display Mode ........................................................................... D-21
     - Sequential Switcher ............................................................... D-21
     - Pulldown Switcher ............................................................... D-21
     - Pointer Tool .......................................................................... D-23
     - Graph Slider Tool ............................................................... D-23
     - Horizontal Magnifying Glass Tool ....................................... D-24
     - Vertical Magnifying Glass Tool .......................................... D-25
     - Magnifying Glass Tool ....................................................... D-26
     - Hand Tool ........................................................................... D-26
   2.2 Measure Mode ......................................................................... D-27
     - Horizontal BG Tool ............................................................. D-27
     - Background Tool ................................................................. D-30
     - Spline BG Tool ..................................................................... D-33
     - Integral Tool ......................................................................... D-34
     - Measure Profile Tool ............................................................ D-36
     - Density Picker Tool .............................................................. D-38
     Automatic Profile Background Recognition ............................. D-40
Contents

INDEX ............................................................................................................................... I-1~I-4

Part G Convenient Menu Functions to Learn

Part F Applying Data to Other Applications

Part E Printing

3. Related Menu Functions (used in both Quant and Profile) ........................................ D-58
   3.1 Modifying the Unit ........................................................................................................ D-58
   3.2 Making Quantification Results into a File ................................................................. D-59
   3.3 Copying & Pasting .................................................................................................... D-60
   3.4 Changing the Position of the Measurement No. ..................................................... D-61

1. File Menu .................................................................................................................... G-2
2. Image Menu ............................................................................................................... G-3
3. Analysis Menu .......................................................................................................... G-3
4. Image Menu .............................................................................................................. G-4

Part E Printing

1. Printing an Image ........................................................................................................ E-2
   1.1 Printing with a Laser Beam Printer ........................................................................ E-2
   (1) Printing an Image .................................................................................................. E-2
   (2) Screen Dumping .................................................................................................. E-9
   1.2 Printing with the PG3000, PG3500, PG4000 or PSD400 High-Resolution Printer (option) ................................................................................................................. E-10
   (1) Printing an Image .................................................................................................. E-10
   (2) Screen Dumping .................................................................................................. E-14

2. Printing Quantified Results .......................................................................................... E-15
   2.1 Using Quant Result for Printing Quantified Results .................................................. E-15
   2.2 Printing Quantified Results using Profile Result ..................................................... E-16
   2.3 Printing Result Table using Distance Result ............................................................ E-16

3. Printing Profile Graph ................................................................................................ E-17

Part F Applying Data to Other Applications

1. Registering Other Applications .................................................................................. F-2
2. Launch Function ....................................................................................................... F-4
3. Copying and Pasting ................................................................................................. F-7
4. Opening a File ......................................................................................................... F-8
   Import File .................................................................................................................. F-8
   Custom ......................................................................................................................... F-9
   PICT ............................................................................................................................ F-9
   TIFF ........................................................................................................................... F-9

5. Saving the File in Other Formats .................................................................................. F-10

Part G Convenient Menu Functions to Learn

1. File Menu .................................................................................................................... G-2
2. Image Menu ............................................................................................................... G-3
3. Analysis Menu .......................................................................................................... G-3
4. Image Menu .............................................................................................................. G-4

Automatic Recognition of a Profile Measurement Region ............................................. D-45
Setting Rf ....................................................................................................................... D-47
Measuring Distance Using the Rf Value ........................................................................ D-48
Applying the Rf Value .................................................................................................. D-50
Setting the Profile Display Method ............................................................................... D-52
Displaying Profile Results ............................................................................................. D-53
Molecular Weight Measurement .................................................................................. D-54
Part A

Before Beginning Operations
1. Image Gauge Ver. 4.0

1. Image Gauge Ver. 4.0 (hereinafter referred to as "this software,") is for analyzing and quantifying the image data input from the Image Reader originally introduced to the market by Fuji Photo Film Co., Ltd. and for image analysis and quantification of image data in RAW, PICT and TIFF format.

2. The sample screens throughout this manual match the functions described and the assumed selections and items that appear. In keeping, when reading the manual.

3. For details on image reading through the IP Reader (BAS series and FDL-5000), IP/Fluorescent Reader (FLA-2000 / 2000G, FLA-3000 / 3000G / A / FLA-5000 / A / FLA-8000) or Chemiluminescent/Fluorescent detecting camera (LAS-1000 / LAS-1000plus / LAS-1000mini), refer to each operation manual.

4. Image files created with versions earlier than this software (MacBAS V2.0 Â‘ V3.0, Image Gauge V.3.01 Â‘ V3.4) can be opened, analyzed and subjected to other operations using this software. Image files created with this software, however, cannot be used with previous versions (upwardly compatible).

5. Use of this software has been confirmed for the following combinations of systems connected to the IP Reader. If other combinations are used, the software may become inoperable, depending on the SCSI.

Macintosh: PowerMac G4 733
Blue G3, G4, G3 MT266/ZIP, MT300/ZIP
* This software cannot be used on the 68K machine.

OS: Mac OS 9.21

SCSI card: 2906 (Adaptec)

CRT: 832x624 or more, 256 color or more
(we recommend the 32,000 color or more.)

LBP: LBP 350 (Canon)
Peripheral devices: Pictrography 3000(32MB/48MB), 3500,4000(120MB), PSD400(96MB)
Application memory: Will differ depending on the image file size handled.

<table>
<thead>
<tr>
<th>Reader</th>
<th>Application Memory</th>
</tr>
</thead>
<tbody>
<tr>
<td>BAS-5000</td>
<td>190MB or more</td>
</tr>
<tr>
<td>FLA-3000/3000G</td>
<td>95MB or more</td>
</tr>
<tr>
<td>BAS-2500</td>
<td>90MB or more</td>
</tr>
<tr>
<td>FLA-2000</td>
<td></td>
</tr>
<tr>
<td>FLA-2000G</td>
<td></td>
</tr>
<tr>
<td>BAS-1800II</td>
<td>75MB or more</td>
</tr>
<tr>
<td>BAS-1800</td>
<td>70MB or more</td>
</tr>
<tr>
<td>BAS-1500</td>
<td>36MB or more</td>
</tr>
<tr>
<td>BAS-1000</td>
<td>25MB or more</td>
</tr>
<tr>
<td>FDL-5000</td>
<td>45MB or more</td>
</tr>
<tr>
<td>LAS-1000</td>
<td>25MB or more</td>
</tr>
<tr>
<td>LAS-1000plus</td>
<td>582MB or more</td>
</tr>
<tr>
<td>FLA-5000</td>
<td></td>
</tr>
</tbody>
</table>

(Image file size + 10~20MB)

This manual has been written based on the assumption that the user has experience using the Macintosh and is familiar with its basic operation and displays.
2. System Configuration

<Supporting Peripheral Devices> (underlined units: available for old users)


Image buffer: IB-200

Pictro: Pictrography 3000 (32MB/48MB), Pictrography 3500, Pictrography 4000 (120MB), PSD-400 (Either one)

LBP: LBP320 Pro (Canon), LBP750 (Canon), LBP350 (Canon), Laser Jet 6L(HP), Laser Jet 4LJ Pro(HP), Laser Writer Select 610(Apple) (Either one)

* 2MB memory should be expanded for the Canon's LBP and HP's LBP.
3. Installing Image Gauge Ver. 4.0

1. Insert the CD-ROM labeled Science Lab into the DC-ROM drive.

2. Drag and copy the Science lab folder in the CD-ROM onto the Macintosh hard disk.

3. Place the 2 function extension files included in the <To Function Extension> folder in the system folder.

4. The software can be used.

5. Installation of Image Gauge Ver. 3.4 is now completed.

After installation, the following dialog box appears at the initial start of Image Gauge Ver.4.0.

You must accept all the terms and conditions of the license agreement in the "License" file located in the Science Lab CD-ROM. Please input your name and the company you work for below, and press continue to use this software.

Name: 
Company: 
Continue
Cancel

Type your name and department, and then click the Continue button.

Image Gauge Ver.4.0 starts up.
1. Using the control panel memory settings, set virtual memory and RAM disks to OFF. If they are used, operations may become unstable and system errors may result.

2. Using the control panel monitor settings, select the 256 color or more option.

3. Depending on the balance between the image size and the memory capacity used by the application, an error can result or image cannot be printed when command for image printing is issued to the LBP. Take appropriate countermeasures as follows.
   * When "Memory insufficient" error display appears:
     Select one of the following 3 alternatives accordingly.
     (1) Set output resolution mode to "Auto" for Print Option settings. The software will automatically select "Auto" mode.
     (2) Increase application memory capacity and then issue the command for printing again.
     (3) Reduce the target area for printing by trimming it.

4. Image files saved with this software version cannot be opened with software versions earlier than Image Gauge Ver. 3.2.

5. After the fitting operation using the calibration line, the result of image processing that was printed to the HP LaserJet 6L with 600dpi in 100% size can be incorrect (negative portion reversed to the positive portion around the Y axis). Such incorrect printing can be avoided by setting 300dpi and 90% instead.

6. To analyze an image, memory capacity same as the size of the target image must be available in the media in which the image exists (HD/MO). Image saving, rotation or flipping is possible only when sufficient capacity is available.

### Image Size vs. Application Size

<table>
<thead>
<tr>
<th>Printer Type</th>
<th>Image Size</th>
<th>Application Size</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>BAS-1000</td>
<td>2MB</td>
<td>25MB</td>
<td>Full print possible when set to &quot;Better&quot;</td>
</tr>
<tr>
<td>BAS-1500</td>
<td>16MB</td>
<td>36MB</td>
<td>Full print possible when set to &quot;Better&quot;</td>
</tr>
<tr>
<td>BAS-2500</td>
<td>64MB</td>
<td>90MB</td>
<td>Full print possible when set to &quot;Good&quot;</td>
</tr>
<tr>
<td>BAS-5000</td>
<td>160MB</td>
<td>190MB</td>
<td>Full print possible when set to &quot;Good&quot;</td>
</tr>
</tbody>
</table>

* Target sizes will differ slightly depending on the printer type or how the image data is complicated.

*When an image cannot be printed:
   It is possible that memory capacity allocated to the printer driver is not sufficient or memory installed in the printer is not enough. Decide appropriate memory size by referring to the User Manual that comes with the printer.
Part B

Viewing an Image
1. Starting Up and Quitting this Software

Starting Up

1. Double-click the icon.

A few seconds after the opening dialog appears, the application will start up.
1. Starting Up and Quitting this Software

Quitting

1. Select Quit from the File menu.

   ![Quit Menu]

   When Image Gauge file format has been specified, the quitting procedure will continue as follows.

2. The following dialog will be displayed asking whether or not you want to save the image data analyzed using Image Gauge.

   ![Save Confirmation Dialog]

3. To save the analyzed data (quantification area data, measurement results, etc.), click YES.
   
   Click NO if you don't want to save the quantification results.

   Note: Analysis data will be added to the Image Gauge image file. File size will increase or decrease according to the volume of the data. Therefore, always pay attention to the data storage capacity of the media.
2. Image Gauge Menu Lists

The following six main menus are displayed on the Image Gauge menu line.

File Edit Image Analysis Windows Applications

Simple explanations of the command groups (pulldown menus) for each main menu follow. Only the commands unique to Image Gauge, and not those for the Macintosh system in general, will be explained.

Note: The command key (⌘) and letter displayed to the right of each command are shortcut keys. Holding down the command key on the keyboard and inputting the appropriate letter will produce the same result as making a selection from the pulldown menu.

File menu

- **Open...** - Opens an image file
- **Trim Again...** - Opens an image file after trimming it
- **Close** - Closes the window
- **Save...** - Opens the original image file
- **Save as...** - Shows file information
- **Revert...** - Sets display observing conditions
- **File Info...** - Changes the unit of distance
- **Preferences** - Changes the unit of quantification
- **Import File** - Imports RAW file
- **Export File** - Imports PICT file
- **Page Setup...** - Imports ROI/Lane data
- **Print...** - Saves file in PICT format
- **Print Pictro...** - Saves file in TIFF format
- **Screen Dump** - Saves file in RAW format
- **Quit** - Saves file in TEXT format

---

2.  Image Gauge Menu Lists

The following six main menus are displayed on the Image Gauge menu line.

File Edit Image Analysis Windows Applications

Simple explanations of the command groups (pulldown menus) for each main menu follow. Only the commands unique to Image Gauge, and not those for the Macintosh system in general, will be explained.

Note: The command key (⌘) and letter displayed to the right of each command are shortcut keys. Holding down the command key on the keyboard and inputting the appropriate letter will produce the same result as making a selection from the pulldown menu.

File menu

- **Open...** - Opens an image file
- **Trim Again...** - Opens an image file after trimming it
- **Close** - Closes the window
- **Save...** - Opens the original image file
- **Save as...** - Shows file information
- **Revert...** - Sets display observing conditions
- **File Info...** - Changes the unit of distance
- **Preferences** - Changes the unit of quantification
- **Import File** - Imports RAW file
- **Export File** - Imports PICT file
- **Page Setup...** - Imports ROI/Lane data
- **Print...** - Saves file in PICT format
- **Print Pictro...** - Saves file in TIFF format
- **Screen Dump** - Saves file in RAW format
- **Quit** - Saves file in TEXT format

---

2.  Image Gauge Menu Lists

The following six main menus are displayed on the Image Gauge menu line.

File Edit Image Analysis Windows Applications

Simple explanations of the command groups (pulldown menus) for each main menu follow. Only the commands unique to Image Gauge, and not those for the Macintosh system in general, will be explained.

Note: The command key (⌘) and letter displayed to the right of each command are shortcut keys. Holding down the command key on the keyboard and inputting the appropriate letter will produce the same result as making a selection from the pulldown menu.

File menu

- **Open...** - Opens an image file
- **Trim Again...** - Opens an image file after trimming it
- **Close** - Closes the window
- **Save...** - Opens the original image file
- **Save as...** - Shows file information
- **Revert...** - Sets display observing conditions
- **File Info...** - Changes the unit of distance
- **Preferences** - Changes the unit of quantification
- **Import File** - Imports RAW file
- **Export File** - Imports PICT file
- **Page Setup...** - Imports ROI/Lane data
- **Print...** - Saves file in PICT format
- **Print Pictro...** - Saves file in TIFF format
- **Screen Dump** - Saves file in RAW format
- **Quit** - Saves file in TEXT format
## Edit menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Z</td>
<td>Makes a duplicate</td>
</tr>
<tr>
<td>Cut</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Copy</td>
<td>C</td>
<td></td>
</tr>
<tr>
<td>Paste</td>
<td>V</td>
<td></td>
</tr>
<tr>
<td>Clear</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Duplicate</td>
<td>D</td>
<td>Forms measured results into a group</td>
</tr>
<tr>
<td>Select All</td>
<td>A</td>
<td>Undo does Group</td>
</tr>
<tr>
<td>Clear Selection</td>
<td>B</td>
<td></td>
</tr>
<tr>
<td>Group</td>
<td>G</td>
<td></td>
</tr>
<tr>
<td>Ungroup</td>
<td>U</td>
<td></td>
</tr>
</tbody>
</table>

## Image menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paste on Clip</td>
<td></td>
<td>Pastes image on the Clipboard</td>
</tr>
<tr>
<td>Default Mag</td>
<td>*</td>
<td>Returns to the default magnification</td>
</tr>
<tr>
<td>Brightness/Contrast</td>
<td></td>
<td>Enhances contrast by compressing the range</td>
</tr>
<tr>
<td>Range Scope</td>
<td>K</td>
<td>Changes the order of colors on the color bar</td>
</tr>
<tr>
<td>Change Color</td>
<td>L</td>
<td>Monitor display will be negative gray</td>
</tr>
<tr>
<td>Clip Image</td>
<td>J</td>
<td>Monitor display will be positive gray</td>
</tr>
</tbody>
</table>

### Settings for Specific Image Formats

**(1)**

<table>
<thead>
<tr>
<th>Color Type</th>
<th>Brightness/Contrast</th>
<th>Monitor display</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Negative Gray</td>
<td></td>
<td></td>
<td>Monitor display will be negative gray</td>
</tr>
<tr>
<td>Positive Gray</td>
<td></td>
<td></td>
<td>Monitor display will be positive gray</td>
</tr>
<tr>
<td>16 Color</td>
<td></td>
<td></td>
<td>Monitor display will be in 16 pseudo-colors</td>
</tr>
<tr>
<td>32 Color</td>
<td></td>
<td></td>
<td>Monitor display will be in 32 pseudo-colors</td>
</tr>
<tr>
<td>Green</td>
<td></td>
<td></td>
<td>Monitor display will be in a green fluorescent color</td>
</tr>
<tr>
<td>Red</td>
<td></td>
<td></td>
<td>Monitor display will be in a red fluorescent color</td>
</tr>
<tr>
<td>Blue</td>
<td></td>
<td></td>
<td>Monitor display will be in a blue fluorescent color</td>
</tr>
</tbody>
</table>

**(2)**

<table>
<thead>
<tr>
<th>Color Type</th>
<th>Brightness/Contrast</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linear...</td>
<td></td>
<td>Adjusts contrast via linear tone curve</td>
</tr>
<tr>
<td>Sigmoid...</td>
<td></td>
<td>Adjusts contrast via S tone curve</td>
</tr>
<tr>
<td>Exponential..</td>
<td></td>
<td>Adjusts contrast via exponential tone curve</td>
</tr>
<tr>
<td>Curve...</td>
<td></td>
<td>Adjusts contrast via curved tone curve</td>
</tr>
<tr>
<td>Triangular..</td>
<td></td>
<td>Adjusts contrast via period tone curve</td>
</tr>
<tr>
<td>Free Hand..</td>
<td></td>
<td>Adjusts contrast via free-hand tone curve</td>
</tr>
</tbody>
</table>
Analysis menu

The items in the Analysis menu will differ depending on the window that is active at the time.

When Image Window is active

- **Renumbers data in order**
- **Renumber**
- **Calibration**
- **Lane Standard**
- **Peak Search...**
- **Option**

(1) **New...**
(2) **Set...**
(3) **Quant Trace...**
(4) **New...**
(5) **None Local Global**
(6) **Table List**

When Result Window is active

- **Renumbers data in order**
- **Renumber**
- **Sort**
- **Calibration**
- **Data Info...**
- **Background**
- **Ratio Standard**
- **Distance Calibration...**
- **Option**

(4) **New...**
(5) **None Local Global**
(6) **Table List**

When Profile Window is active

- **Renumbers data in order**
- **Renumber**
- **Data Info...**
- **Peak Search...**
- **BG Search**
- **Copy BG Line...**
- **Clear BG Line...**
- **Copy RF Ratio...**
- **Option**

(7) **Display...**
(8) **Display...**

- **Sets profile display**
- **Sets parameters for automatic recognition of profile backgrounds**
- **Sets parameters for automatic recognition of lanes**

---

(1) **New...**
(2) **Set...**
(3) **Quant Trace...**
(4) **New...**
(5) **None Local Global**
(6) **Table List**

---
2. Image Gauge Menu Lists

Windows menu

<table>
<thead>
<tr>
<th>Windows</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Image</td>
<td>#1 Displays image</td>
</tr>
<tr>
<td>View</td>
<td>#2 Displays whole image</td>
</tr>
<tr>
<td>Profile</td>
<td>#3 Displays profile</td>
</tr>
<tr>
<td>Info</td>
<td>#4 Displays Info window</td>
</tr>
<tr>
<td>Quant Result</td>
<td>#5 Displays Quant mode measurement results</td>
</tr>
<tr>
<td>Profiles/MW Result</td>
<td>#6 Displays Profile/MW mode measurement results</td>
</tr>
<tr>
<td>Distance Result</td>
<td>#7 Displays Distance mode measurement results</td>
</tr>
</tbody>
</table>

Applications menu

<table>
<thead>
<tr>
<th>Applications</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Entry ...</td>
<td>#E Enters other applications</td>
</tr>
</tbody>
</table>
3. Viewing an Image

3.1 Image Reading

See "Image Reader" operation manual for detailed operations.

3.2 Opening an Image File

1. Select Open... from the File menu to display the image file dialog.

```
File
Open...  ◆
Trim Again...  ◆
Close  ◆
Save...  ◆
Save as...  ◆
Revert...  ◆
File Info...  ◆
Preferences  ◆
Import File  ◆
Export File  ◆
Page Setup...  ◆
Print...  ◆
Print Pictro...  ◆
Screen Dump  ◆
Quit  ◆
```

Note: With Image Gauge, only one image file can be opened at one time. If some image file has been altered, the following dialog will be displayed. Select YES or NO.

```
Save this file before closing ?

YES

NO  Cancel
```
2 Double-click the file name you want to open in the preview window.

![Image of a preview window with a drop-down menu arrow and buttons for 'Create', 'View', 'Desktop', 'MacintoshHD', 'southern', 'Trash', 'Eject', 'Open', 'Cancel'].

Drop-down menu arrow

Click when you want to display the image preview.

Displays the small preview image.

When the desired file cannot be found in the current folder, use the drop-down menu arrow to display other folders or files.

Note: The image read by the Image Reader can be opened with the Open... command. However, in this case, the Trimming dialog will be displayed. (See next page, 3.3 Trimming an Image, for details.)
3.3 Trimming an Image

1. Select Trim Again... from the File menu to display the image file dialog.

   Trim Again...
   
   File
   Open...  
   Trim Again...
   Close
   Save...
   Save As

2. Open the desired file.
   (If the desired file cannot be found in the current folder, use the drop-down menu arrow and display other folders or files.)

3. After a file has been selected, the following Trimming dialog will appear. Referring to the table on the following page, set the region of interest (for trimming).

   Trimming box

   Range Scope (see p. B-27, 5.3 Enhancing Contrast with Range Scope.)
3.3 Trimming an Image

<table>
<thead>
<tr>
<th>Shape of Pointer</th>
<th>Purpose</th>
<th>Operation Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resizing</td>
<td>When the mouse pointer is placed on the frame or a corner of the trimming box, its shape will change as shown on the left, allowing it to be dragged.</td>
<td></td>
</tr>
<tr>
<td>Moving</td>
<td>When the mouse pointer is brought inside the trimming box, its shape will change to , allowing it to be dragged.</td>
<td></td>
</tr>
<tr>
<td>Resetting</td>
<td>When you bring the mouse pointer back outside the trimming box (the pointer will change to ), click the mouse. The trimming box will disappear, and settings can be redone with dragging.</td>
<td></td>
</tr>
</tbody>
</table>

4 If you click the to select it, the following display will be displayed. You can set the width/height of trimming frame (pixels) and the range of the Range Scope by inputting each value directly.

![Trimming dialog box](image)
5 For trimming only, when there's no need for rotated/flipped display, click OK. (To display an image after rotating/flipping it, proceed to the next page.)

Note: When sufficient application memory capacity has not been allotted, the OK button may not be activated, as illustrated below. In such a case, add memory or reduce the trimming area to activate the OK button and then click it.
6 To display an image after rotating/flipping it, click Rotate/Flip... in the Trimming dialog and set rotation/flipping conditions in the Rotate/Flip dialog that will appear.

7 After completing trimming and rotation/flipping settings, click OK in the Trimming dialog.
3.4 Dividing and Saving an Image

1. To divide the image currently displayed in the Trimming dialog into several files, click Save as... after specifying trimming options. Only the image will be divided. ROI and other additional information will not be saved.

2. Input the file name, specify where it should be saved and click OK.

3. When the image file has been created, the original Trimming dialog will be displayed.
4. Names of the Parts of the Image Gauge Window

- Title bar
- Menu line
- Close box
- Mode selector
- Tool box (Changes with each mode)
- Scroll box
- Scroll arrow
- Image area
- Tool box
- Zoom box
- Unit
- Magnification ratio
- Size of pixels
- Image size
- Selected tone curve
- Selected mode (here, Annotation)
- Test Image.v2
- 204.80 x 409.60 mm
- 200 PSL (1)
- Size box
- Unit
- Menu line:
  - File
  - Edit
  - Image
  - Analysis
  - Windows
  - Applications
5. Changing the Monitor Display

5.1 Changing the Display Color

1. Select Color Type from the Image menu and then select the desired monitor display command from the submenu.

<table>
<thead>
<tr>
<th>Color Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Negative Gray</td>
<td>Negative gray display (low density regions are white, high density regions are black).</td>
</tr>
<tr>
<td>Positive Gray</td>
<td>Positive gray display (low density regions are black, high density regions are white).</td>
</tr>
<tr>
<td>16 Color</td>
<td>Displays in 16 pseudo-colors.</td>
</tr>
<tr>
<td>32 Color</td>
<td>Displays in 32 pseudo-colors. (Designation of colors for high and low density regions is done with Brightness/Contrast.)</td>
</tr>
<tr>
<td>Green</td>
<td>Displays in a green fluorescent color</td>
</tr>
<tr>
<td>Red</td>
<td>Displays in a red fluorescent color</td>
</tr>
<tr>
<td>Blue</td>
<td>Displays in a blue fluorescent color</td>
</tr>
</tbody>
</table>

5.2 Adjusting Contrast

1. Select Brightness/Contrast... from the Image menu and then select the desired contrast adjustment (tone curve) command from the submenu.

<table>
<thead>
<tr>
<th>Brightness/Contrast...</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linear...</td>
<td>Adjusts contrast with a linear curve (see 3 on p. B-18).</td>
</tr>
<tr>
<td>Sigmoid...</td>
<td>Adjusts contrast with an S tone curve (see 4 on p. B-19).</td>
</tr>
<tr>
<td>Exponential...</td>
<td>Adjusts contrast with an exponential tone curve (see 5 on p. B-21).</td>
</tr>
<tr>
<td>Curve...</td>
<td>Adjusts contrast with a tone curve (see 6 on p. B-23).</td>
</tr>
<tr>
<td>Triangular...</td>
<td>Adjusts contrast with a period tone curve (see 7 on p. B-25).</td>
</tr>
<tr>
<td>Free Hand...</td>
<td>Adjusts contrast with a free-hand tone curve (see 8 on p. B-26).</td>
</tr>
</tbody>
</table>
2. A Change Curve Dialog like the one below will be displayed. (When monitor display will be in color, you can use Color: 16 to select 16 or 32 colors for black and white in low density regions.

Density distribution on an image is displayed.

Save... Saves the set 5 kinds of tone curves as a file.
Load... Calls up the tone curves saved as a file. When this file is called up on another image, these tone curves can be applied to it.
Edit Values... Used when directly inputting values for density band of gradation and/or its top/bottom values.

To change the contrast adjustment command, make selections from the pulldown menu for Kind: Linear.
3 Linear

3-1 Drag the adjuster (↕) inside the gradation bar until contrast is appropriate. Image contrast will change in realtime in keeping with the dragging.

Another method for adjusting image contrast is to drag each dial on Bright: and Cont: with the mouse. Or, click the [Edit Values] to select it, the following dialog will be displayed. Input the desired values directly.

3-2 After contrast has been adjusted, click OK.
4 Sigmoid

4-1 Drag Cont: dial to adjust S tone. (Sigmoid coefficient will be changed.)

4-2 By dragging the adjusters on the left and right, you can change the contrast band.
4-3 Drag the limitation adjustor located on upper and lower to change the density band.

4-4 Or, click the **Edit Values** button to select it, the following dialog will be displayed. Input the desired values directly.
5 Exponential

5-1 Drag Curve: dial to adjust curvature of the exponential curve. (Values of the curvature parameter will be changed.)

5-2 By dragging the upper limit bar, you can slide the exponential curve without changing the curvature.
5-3 Or, click the [Edit Values] to select it, the following dialog will be displayed. Input the desired values directly.

![Brightness/Contrast dialog]

- Range:
  - Low:
  - High: 10471

- Exponential:
  - Top:
  - Bottom:
  - Curve: 20

5-4 After adjusting the contrast, click OK.
6 Curve

6-1 Change the tone curve by dragging the mouse.

6-2 By dragging the curve adjusters on the left and right, you can change the contrast band.
When the tone curve is dragged with the option key pressed, it will change to a Sigmoid curve.

6-3 Or, click the Edit Values... to select it, the following dialog will be displayed. Input the desired values directly.

6-4 After adjusting the contrast, click OK.
7 Triangular

7-1 You can move the periodic-change gradation bar by dragging it.

7-2 When you drag the Bright: dials ( ) with the mouse, you can adjust the period.

7-3 After adjusting the contrast, click OK.
8 Free Hand

8-1 By dragging the mouse in Free Hand, you can make a free-hand line (tone curve).

8-2 After adjusting the contrast, click OK.

Import Function
When Import... is clicked with Free Hand selected, tone curve data will be read from the TEXT file and setting will be possible using the values that have been input.

Example of file contents: The range of values input correspond to image contrast.

<table>
<thead>
<tr>
<th>0Ø</th>
<th>2Ø</th>
<th>4Ø</th>
<th>8Ø</th>
<th>16Ø</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ørepresents the Return key</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

User Tips
- Image data and default display
  Display formats when the image window was opened and when the Trimming dialog was opened will depend on the image data types.
- BAS series (BAS1000/1500/2000/2500/3000/5000) ........... (Exponential + Negative) display
- FLA series (FLA2000/FLA2000G/FLA3000/FLA3000G) .... (Exponential + Negative) display
- FDL5000 ................................................................. (Linear + Positive) display
- LAS series (LAS1000/1000C/1000plus) .......................... (Linear + Negative) display
- Import files (Custom, TIFF, PICT) ............................... (Linear + Positive) display
5.3 Enhancing Contrast

Range Scope is a function for enhancing the contrast of a portion that has been arbitrarily selected for display from the image file. With an 8-bit image, there will be almost no change, but for an image with contrast exceeding 8 bits, the contrast level will be concentrated in a narrow range; it is possible to achieve clearer display by using Range Scope function on this portion (of narrow range) to compress it.

Note: Range Scope function only changes the display and does not at all influence the quantitative accuracy.

1. Select Range Scope... from the Image menu.

2. Drag the View Scope frame displayed on the image and move it to the region of interest. (The inside of the box will be displayed in the lower right View Scope magnified.)
3 Drag the adjuster in the Range Scope box and arbitrarily set the contrast level.

4 Click the [Edit Values...] to select it, the following dialog will be displayed. Input the desired values directly.

5 Click OK. (The image will then be redisplayed at the set contrast level.) Click the Reset to cancel it.
5.4 Displaying an Entire Image

Even when enlargement has been done or the window size modified, it is always possible to display the entire image and determine the region of analysis. Image area can also be scrolled.

1 Select View from the Window menu.

<table>
<thead>
<tr>
<th>Windows</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Image</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>View</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>Profile</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>Info</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>Quant Result</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>Profile/MW Result</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>Distance Result</td>
<td>7</td>
<td></td>
</tr>
</tbody>
</table>

2 The View window for the entire image will be displayed.

Green frame: Image area developed in memory. To move, drag while holding the option key down.

Red frame: Position displayed on current image area. Can be scrolled in realtime within the green frame.
5.5 Displaying Informations Related to Image

Image size and pixel intensity can be displayed.

1. Select Info from the Windows menu.

<table>
<thead>
<tr>
<th>Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image 1</td>
</tr>
<tr>
<td>View 2</td>
</tr>
<tr>
<td>Profile 3</td>
</tr>
<tr>
<td>Info 4</td>
</tr>
<tr>
<td>Quant Result 5</td>
</tr>
<tr>
<td>Profile/MW Result 6</td>
</tr>
<tr>
<td>Distance Result 7</td>
</tr>
</tbody>
</table>

2. The Info bar will be displayed beneath the Menu bar.

```
X=67.60  Y=21.60 mm   QL:144  PSL:6.160e+00
```
Part C

Quantifying an Image
1. Four Analysis Modes

Image Gauge has four analysis modes: Annotation, Quant, Profile, and Distance. Analysis tools have been grouped and stored according to each analysis mode. (However, some analysis tools are used in common by each mode.)

Switch between modes by using the pulldown menu from the Mode selector.

An overview of the four modes is presented below.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Annotation</td>
<td>Used for DTP operations, such as writing text or arrows onto the displayed image or bringing in other figures.</td>
</tr>
<tr>
<td>Quant</td>
<td>Measures the radioactivity within a specified region. The mouse is used to enclose (define) the region for measurement, and the radiation dose within that region is displayed in terms of units of photostimulated luminescence (PSL) or cnt or LAU in the standard. (If an arbitrary unit has been set, it is also possible to display results in terms of it.) This mode can be used to apply background subtraction, setting of standard values, and group formation, etc., to quantified results.</td>
</tr>
<tr>
<td>Profile/MW</td>
<td>Measures the PSL value for the designated region and displays a related profile graph. Quantified measurement and background subtraction can also be done on the profile graph obtained. Also, molecular weight can be measured.</td>
</tr>
<tr>
<td>Distance</td>
<td>Measures distance and angles.</td>
</tr>
</tbody>
</table>
2. Using the Analysis Tools

2.1 Analysis Tools Common to Each Mode

Explained here are the analysis tools stored within and used in common by all four modes.

**Pointer Tool**

The objects made with the tool box in each mode can be selected (activated).
(It is possible to select more than one object at one time.)
In the example shown below, operations for selecting objects made with the Oval tool in Quant mode are shown.

1. Select the Pointer tool ( ) from the tool box.

2. The 3 objects below, which were created with the Oval tool, will be used in this example. (As these objects have not yet been selected, they will be displayed in blue.)

3. To select No. 3, place the mouse pointer on it and click. (The selected object — No. 3 — will change to red.)

*Note: By dragging the handles that appear with the selected object, it is possible to adjust the object.*
4 To choose multiple objects, drag the region so that it includes all of the desired objects, which will allow all of them to be selected at once.

Note: When multiple objects are selected (displayed in red), it is possible to delete them (with the delete key), move them (by dragging), and conduct other operations on them all at once.

To immediately adjust an object after creating it with the other tools for each mode, you can press the Tab key to select the Pointer tool. To recreate objects, press the Tab key once more and return to the original tool.
Density Picker Tool

It is possible to display the coordinates of any position (pixel) on the image, its QL value, PSL value, cnt value, LAU value (or any newly set unit system).

1. Select the Density Picker tool ( ) from the tool box.

2. When the mouse pointer is moved inside the image, it will change to . At the desired position (pixel) on the image, hold down the mouse button. The coordinates of the clicked position (pixel), the QL value, PSL value or LAU value (standard) will be displayed on the right of the tool box.

   * When the Info bar is displayed, information on the clicked position (pixel) will be displayed in the Info bar.

3. Or, by holding down the command ( ) key and clicking a point on the screen, the XY axes of the coordinates will appear on the image and the XY coordinates will appear on the right of the tool box. To move the axes, use the mouse or the arrow keys on the keyboard. (The XY coordinates will change in realtime in accordance with the movement.)

4. If the command ( ) key is held down and the screen clicked once more, the XY axes of the coordinates will disappear.
QL, PSL, cnt/LAU value:

The QL value on the image data read with the IP Reader is the gradation-divided value of the image data read using logarithms. The PSL value is the linear value derived by performing operations on the sensitivity, latitude and contrast of the QL value at the time it was originally read. However, for the image read with the IP Reader (FDL-5000) for Microscopy, the cnt value (PSL value multiplied by 31.251 of coefficient) is displayed. For the fluorescent image read with the IP/Fluorescent Reader (FLA-2000/2000G), the LAU value is displayed as a unit that corresponds to the PSL value. This way, even if the reading conditions for images differ, as long as their energy levels are the same, a uniform PSL value will be expressed. When a unit system other than PSL has been set, operations will be performed based on the QL value.

With the import function, the QL value will be displayed even for opened image data. This value will depend on the hardware or software used to create the image data.
Magnifying Glass Tool

This tool is used to enlarge or reduce a displayed image.

1. Select the Magnifying Glass tool (🔍) from the tool box.

2. When the cursor is placed inside the image, it will change to 🔍.

3. When the mouse is clicked on the image, the image will be enlarged with the point clicked serving as the center. (With each click, magnification will increase, 2, 4, and 8 times.)
4 To return an enlarged image to its original state, hold the shift key on the keyboard down and click. With each click, the image will be reduced. (When the shift key is pressed, the cursor will change to .

By double-clicking the tool box, you can restore the enlargement ratio to its original status.

In each mode, even if a different tool has been selected, by pressing the Ctrl key on the keyboard, the Magnifying Glass tool will change to selected status.
This tool is used to scroll an image.

1. Select the Hand tool (hand) from the tool box.

2. Place the cursor inside the image and drag the mouse. (This will cause the portions of the image not displayed to appear on the screen.)

3. Another method for changing the display position is to use the mouse on the scroll bar (right or bottom edges).

   By double-clicking the hand on the tool box, you can restore the scroll to its initial status.

   In each mode, even if a different tool has been selected, pressing the option key on the keyboard will allow the hand tool to appear in selected status.
2.2 Annotation Mode

Image Selector tool

The Image Selector tool is used for clipping an image out and for cut and save functions.

1. Select the Image Selector tool ( ) from the tool box in Annotation mode.

2. When the cursor is placed inside the image, it will change to . Drag it to select what you want to clip out.
3. Select Clip Image... from the Image menu.

4. When the Image Resize dialog is displayed, select the desired magnification ratio and click OK.
5 The clipped image will be displayed on the screen. Even if the original image is modified, the necessary image (before modifying) can be left displayed. It can also be used for copy and paste functions.

6 By clicking the [ ] on the tool box while holding down the option key, you can display the Enter Rect Coordinate dialog. Input values within it to set the size of the rectangle as desired.

You can select the entire image by double-clicking the [ ] on the tool box.
Text Tool

This tool is used to overlay text on an image.

1. Select the Text tool ( ) from the tool box in Annotation mode.

2. When the cursor is placed inside the image, it will change to . Place the cursor at the point you want to overlay text and click. (The Text & Font dialog will appear.)

3. Input to the dialog box the text you want to display and use the pulldown menu to make selections for display direction, font, style, character size, and display color.

   Use :Draw Vertical when you want to write text vertically.

Note: Japanese text cannot be written vertically.
4 If you end by clicking OK, the text will appear on the image under the set conditions.

5 If you double-click the created text with the Pointer tool, the Text & Font dialog will reappear, making it possible to redo settings.
Arrow Tool

This tool is used to overlay arrows on an image.

1. Select the Arrow tool ( ) from the tool box in Annotation mode.

2. When the cursor is placed inside the image, it will change to . Drag from the place on the image where you want to start the arrow to the place where you want to end it and an arrow will be written there. (The ending point is where the head of the arrow will be.)

3. To correct the length and angle of the created arrow, select the pointer tool and drag the grow handle in the figure below.

4. If you double-click the Arrow tool, an Arrow dialog like the following will appear. In this dialog, you can modify the settings for arrows.

If you double-click the on the tool box, the Arrow dialog will appear, allowing you to prepare settings in advance.
Info Stamp Tool

This tool is used to display the file name and other parameters for an image.

1. Select the Info Stamp tool ( ) from the tool box in Annotation mode.

2. When the cursor is placed inside the image, it will change to . Click and an Information Stamp dialog like the following will appear.

   ![Information Stamp Dialog]

<table>
<thead>
<tr>
<th>File Kind: .inf</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header</td>
</tr>
<tr>
<td>Original Name</td>
</tr>
<tr>
<td>IP Type</td>
</tr>
<tr>
<td>Pixel Size 1</td>
</tr>
<tr>
<td>Pixel Size 2</td>
</tr>
<tr>
<td>Pixel Depth</td>
</tr>
<tr>
<td>Pixel Number</td>
</tr>
<tr>
<td>Rester Number</td>
</tr>
<tr>
<td>Sensitivity</td>
</tr>
<tr>
<td>Latitude</td>
</tr>
<tr>
<td>Date &amp; Time 1</td>
</tr>
<tr>
<td>Date &amp; Time 2</td>
</tr>
<tr>
<td>Reserved</td>
</tr>
</tbody>
</table>

3. Each item within the dialog can be selected by clicking. (A check mark will appear to the right of items that have been selected.) To undo a selection, click the check mark for it. (The check mark will disappear and the selection will be undone.) Only the items selected in this dialog will be displayed on the image.
4 After selecting the items you want to display, click OK. The selected items will be displayed on the image.

5 If you double-click the Info Stamp you have created with the Pointer tool, you can reset the information.

If you double-click the on the tool box, the Stamp Setup dialog will appear, allowing you to prepare font and other settings in advance.
Scale Bar Tool

This tool is used for displaying the scale bar on the image.

1. Select the Scale Bar tool ( ) from the tool box in Annotation mode.

2. When the cursor is placed inside the image, it will change to . If you click it on the image, a Scale Bar dialog like the following will be displayed.

   ![Scale Bar Dialog]

   - **Bar Length**: 10.0
   - **Unit**: mm, um, nm, pixel
   - **Font Size**: 9
   - **Line Width**: 1
   - **Color**: Green
   - **Line Back**: White
   - **Position**: Center

   - **Option Edge Lines**: For selecting whether or not to have vertical lines on the edges of the scroll bar.

3. Select the length of the scale (bar), the unit, edges (or not), etc., and then click OK. A scale bar will then be displayed on the image.

4. If you double-click the scale bar you have created using the Pointer tool, you can redo the settings for it.
PICT Stamp Tool

This tool is used to bring a PICT file into an image.

1. Select the PICT Stamp tool ( ) from the tool box in Annotation mode.

2. When the cursor is placed inside the image, it will change to . Click and a selection dialog like the following will be displayed. From it, select the PICT file that you want to bring in and click Open.

3. An Image Resize % dialog like the following will appear. After you set the size of the image you want to bring in and click, the PICT file will be brought onto the image.
In the above example, Profile has been brought in over the image and displayed.

4 Using the Pointer tool, double-click the PICT file that has been brought in to reposition it if desired.

*Note: Using Copy & Paste, you can bring in data from other applications.*
Menu Functions Related to Annotation

It is possible to put a desired comment on an Info Stamp.

1. Select File Info... from the File menu.

2. The File Information dialog will appear. Click the Comment input section on the list.

3. Input the desired characters in the input box and click Change.
4 After OK is clicked, by checking the Information Stamp dialog for the Info Stamp tool, you can display the input comment.

Note: By selecting the line feed code with the Delimiter Option and clicking Export... , it will be possible to use the file information with Sun and MS-DOS. An information file will be created for this purpose.
2.3 Quant Mode

Rectangle Tool

This tool is used to enclose a desired region with a rectangle.

1. Select the Rectangle tool ( ) from the tool box in Quant mode.

2. Place the cursor on the edge of the desired region and drag it to enclose the region.
   (To enclose it with a square, drag while holding the shift key down.)

3. When the region has been appropriately enclosed, release the button on the mouse. (At this time, the area will be selected automatically and displayed in red.)

Notes:
1. By dragging the four grow handles (which are red) with the Pointer tool, you can freely modify the size.
2. By displaying the Info bar, informations concerning the ROI's start and/or end points can be confirmed.
Freehand Tool

This tool is used to enclose the desired region in a freehand curve.

1. Select the Freehand tool ( ) from the tool box in Quant mode.

2. Place the cursor at one end of the desired region and hold down the mouse button (do not release it).

3. When the mouse is dragged with the button held down, a freehand curve will be drawn. Drag the mouse to enclose the desired region.
4 When you release the mouse button at the end point, it will be connected directly to the starting point.
(At this time, the area will be selected automatically and displayed in red.)

Notes:
1 By dragging the grow handle (red) with the Pointer tool, you can freely change the size.
2 If you double-click the tool box, the Trace Resolution dialog will appear. By selecting the desired number of pixels, you can set the number of pixels between points.

![Trace Resolution Dialog]
Polygon Tool

This tool is used to enclose the desired region in a polygon.

1. Select the Polygon tool ( ) from the tool box in Quant mode.

2. Place the cursor at one end of the desired region and click to define the starting point of the polygon that will enclose the region.

3. When the mouse is moved with the mouse button released, a corresponding straight line will be drawn from the starting point.
4 Click the place on the polygon at which you want to end the line segment. (This will be a fixed point.)

5 When the mouse is moved with the mouse button still released, a straight line will be drawn from the point just fixed.

6 Repeat the preceding step as many times as necessary and enclose the shape of the desired region.

7 When you double-click the last point, a straight line will connect it to the starting point. (At this time, the area will be selected automatically and displayed in red.)

Note: By dragging the grow handles (red) with the Pointer tool, you can freely modify the size.
Oval Tool

This tool is used to enclose the desired region in an oval.

1. Select the Oval tool ( ) from the tool box in Quant mode.

2. Place the cursor at the edge of the desired region and drag to enclose it. (To enclose the region in a circle, hold down the shift key and drag.)

3. When the region has been enclosed, release the button on the mouse. (At this time, the area will be selected automatically and displayed in red.)

Note: By dragging the grow handles (which are red) with the Pointer tool, you can freely modify the size.
This tool is used to enclose the desired region in a slanted rectangle.

1. Select the Slanted Rectangle tool ( ) from the tool box in Quant mode.

2. Place the cursor at the edge of the desired region, drag briefly in the direction you want to measure, and release the button on the mouse. At this time, the direction will be determined by these 2 points (the first one set and the second one dragged to).

3. When the desired region has been enclosed, click the mouse. (At this time, the area will be selected automatically and displayed in red.)

Note: By dragging the rotation handle (green) and the grow handle (red) with the Pointer tool, you can freely modify the size.
Ladder Tool

This tool is used to enclose the desired region within a ladder.

1. Select the Ladder tool ( ) from the tool box in Quant mode.

2. Place the cursor at the edge of the desired region, drag it briefly in the direction you want to measure, and release the button on the mouse. At this time, the direction will be determined by these 2 points (the first one set and the second one dragged to).
3 When the desired region has been enclosed, click the mouse.

4 By moving the mouse to the first position marked and clicking it, you can set a dividing line (which will move along with the mouse). Click the points at which you want to add dividing lines. End with a double-click. (At this time, the area will be selected automatically and displayed in red.)
Note: With grow handle (red) and rotation handle (green), you can freely change size and angles. By dragging the slide handles (blue), it is possible to change the position of the dividing lines.

If you undo the selection, the display will change to something like the following.
Matrix Tool

This tool is used to enclose the desired region in a matrix.

1. Select the Matrix tool ( ) from the tool box in Quant mode.

2. Place the cursor at the edge of the desired region, drag it briefly in the direction you want to measure, and release the button on the mouse. At this time, the direction will be determined by these 2 points (the first one set and the second one dragged to).
3. When the desired region has been enclosed, click the mouse.

4. The Matrix Dimension dialog will be displayed, so in the input column in the dialog, input the desired matrix size from the keyboard. (The smallest matrix cell will be 2mm.)
5 Click OK to display the matrix box to be used for quantification. (At this time, the area will be selected automatically and displayed in red.)

Note: By dragging the rotation handle (green) and grow handle (red) with the Pointer tool, you can freely modify the size and angles.

When the selection is undone, the display will change to something like the following.
Free-Division Matrix Tool

This tool is used to enclose the desired region within a matrix with freely set divisions.

1. Select the Free-Division Matrix tool ( ) from the tool box in Quant mode.

2. Place the cursor at the edge of the desired region, drag it briefly in the direction you want to measure, and release the button on the mouse. At this time, the direction will be determined by these 2 points (the first one set and the second one dragged to).

3. When the desired region has been enclosed, click the mouse.
4 When the cursor is placed inside the enclosed area, a slice line will be displayed in first direction. (This direction will be the direction in which dragging was done from the first point.) Click in order the points at which you want to make slices and double-click the last point.

5 A slice line will appear in a second direction. As you did before, click in order the points at which you want to make slices.
6 When you double-click the last point, you will have created a matrix that has been freely divided.

Note: By dragging the rotation handle (green) and grow handle (red) with the Pointer tool, you can freely change size and angles. Using the slide handle (blue), you can change the position of the slice lines.

When the selection has been undone, the display will change to something like the following.
Automatic Band Tool

Automatically recognizes the bands within the specified lane.

1. Select the Auto Band Tool from the tool box in Quant mode.

2. Place the crosshair at the starting point of the desired region and drag the mouse in the direction that the lanes will unfold, to the end of the lanes. Release your finger from the mouse button. At this time, the direction will be determined by these two points -- the first point and the point at which you released the mouse button after dragging the mouse.
3 With your finger still off the mouse button, move the mouse. When you have enclosed the entire region of the lanes you want recognized, click the mouse. At this time, if you have enclosed too large an area, you will not be able to have the lanes correctly recognized.

**Note:** Up until you click the mouse button and define the region, you will be able to freely modify the size of the specified frame by using the point from which you began dragging as a fixed point.
4. The Quant Auto Lane & Band dialog will be displayed. Input the number of lanes in the input box in the dialog.

Assign Lanes Evenly: Lanes of the same width are placed within a rectangle with the same amount of space between them. The lanes on both edges are positioned to touch the rectangle.

Find Lanes: Creates lanes by recognizing lane widths, numbers, and positions from the image.

Same Lane Width: Makes lane width even.

Lane Count: Input when the number of lanes has been set ahead of time.

Band Parameter: The larger the number that is input, the more the degree of band separation is improved.

5. Click OK. The lanes and bands in the specified region will be automatically recognized.
Correcting a Ladder/Freehand Matrix

Corrects existing ladders and freehand matrixes, and automatic band recognition.

When the Slide Handle has been specified with the Pointer and the key is pressed, the Pointer will change to . If you drag the mouse in this condition, the slide will be copied. If you press the shift key, the Pointer will change to . If you click the mouse in this condition, the slide will be deleted.
Titer Plate Tool

This tool is mainly used to specify fluorescent image areas using the titer plate.

1. Select the Titer Plate Tool from the tool box in Quant mode.

   * When the Titer Plate Tool has been specified and clicked on the image, the plate used the last will be displayed. (The default in this software is 96 holes).

2. The Dots Properties dialog as shown below will appear. Specify plate conditions.

   - **Format**:
     - **Horizontal**: Enter the number of horizontal wells.
     - **Vertical**: Enter the number of vertical wells.
     - **Direction**: Select how to display the index.
     - **Diameter**: Enter diameter of the well in unit of mm.
     - **Pitch**: Enter the distance between horizontal wells and also that between horizontal and vertical wells in unit of m.

   Format:
   - **Horizontal**: Enter the number of horizontal wells.
   - **Vertical**: Enter the number of vertical wells.
   - **Direction**: Select how to display the index.
   - **Diameter**: Enter diameter of the well in unit of mm.
   - **Pitch**: Enter the distance between horizontal wells and also that between horizontal and vertical wells in unit of m.
3 Click ![OK button](image) and then click the cursor on the image. The selected plate will be displayed.

![Image of plate selection](image)

4 The plate position can be adjusted by mouse dragging and the angle by dragging the rotation handle.

![Rotation handle](image)

5 The diameter of the well and the distance between horizontal wells and that between horizontal and vertical wells can be re-set in the Dots Properties dialog that appears by double-clicking the plate on the image.

![Dots Properties dialog](image)
Magic Wands Tool

This tool is used to semi-automatically enclose the desired region.

1. Select the Magic Wands tool (LineWidth) from the tool box in Quant mode.

2. When the cursor is placed inside the image, it will change to (LineWidth). Place the (LineWidth) cursor on the region you want to enclose (without letting go of the mouse). At this point, the region can be drawn automatically. Drag to enclose the region in the best way and then release the mouse.
3. At this time, the area will be automatically selected and outlined in red. If you want to make fine adjustments, select the Pointer tool from the tool box and then drag the grow handle.

Note: If you double-click the on the tool box, the Trace Resolution dialog will appear. By selecting the desired number of pixels, you can set the number of pixels between points.
Free Edit Tool

This tool is used to modify the shape of ROI. It is used for ROI created with the Free Hand tool and Polygon tool.

1. Select the Free Edit tool, 

2. When the mouse pointer is placed inside the image, it will change to 

2-1 Partial deletion
Drag the mouse and with the Pointer mark off 2 places on the ROI.

When the mouse is released after the places have been marked off, the Pointer will change to 
Place the above the portion you want to remain and click to have the ROI edited.

2-1 Partial addition
The same as for a deletion, use the Pointer to mark off 2 places on the ROI.

Release the mouse after the places have been marked, place the above the original ROI, and click to edit.
Menu Functions Related to Quant

Making an ROI Data File

By filing a created ROI (Region of Interest; made and enclosed with tools in Quant mode), it is possible to call it up for other images and reuse it.

1. Using the Pointer tool, select the ROI that you want to save.

2. Select ROIs... from the Export File submenu of the File menu.
3 Set the file name and destination (folder it should be stored in) and then save it.

4 When you want to use it on a different image file, open the file in Quant mode and select ROIs... from the Import submenu of the File menu to import it.
Using Duplicate

This function is used to duplicate single or multiple objects that have been created.
On an image that has multiple lanes, as shown below, we will use as an example the procedure for quantifying each lane in the same format.

1 Quantify one lane. With the Pointer tool, activate the ROI that you want to copy.

2 Select Duplicate from the Edit menu.

<table>
<thead>
<tr>
<th>Edit</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>⌘ Z</td>
</tr>
<tr>
<td>Cut</td>
<td>⌘ X</td>
</tr>
<tr>
<td>Copy</td>
<td>⌘ C</td>
</tr>
<tr>
<td>Paste</td>
<td>⌘ V</td>
</tr>
<tr>
<td>Clear</td>
<td></td>
</tr>
<tr>
<td>Duplicate</td>
<td>⌘ D</td>
</tr>
<tr>
<td>Select All</td>
<td>⌘ A</td>
</tr>
<tr>
<td>Clear Selection</td>
<td>⌘ B</td>
</tr>
<tr>
<td>Group</td>
<td>⌘ G</td>
</tr>
<tr>
<td>Ungroup</td>
<td>⌘ U</td>
</tr>
</tbody>
</table>
3 A copy of the selected ROI will be displayed on the screen. (It will be as selected.)

Drag the duplicated ROI with the Pointer, move it to another lane, and readjust the size and position, thus making it into the desired ROI.

You can duplicate an object by activating it and then dragging it with the command key held down.
Saving Quantification Areas

1. Activate (red) the quantification setting area(s) on the image.

2. Select Export File from the File menu and then ROIs/Lanes from the submenu.

3. Input the file name in the open dialog and specify the destination for saving.

4. The saved file will be displayed as the icon shown below.
Retrieving the Saved Quantification Areas

1. Select Import File from the File menu and then ROIs/Lanes from the submenu.

2. Specify the saved quantification area in the open dialog and open it.

3. The offset values can be specified in the Position dialog below.
In the saved quantification area, the position on the image when the area was saved is stored.

For example, when retrieving the quantification area stored as shown at the left on a different image B, the area will be positioned on Image B according to the image positioning conditions on Image A (at the 100 pixel/100 pixel position when viewed from the top left corner), assuming that Left offset: 0 pixel and Top offset: 0 pixel in the Position dialog.

When offset values are changed to Left: 50 pixels and Top: 50 pixels on the Image B in the Position dialog, the quantification area will be shifted as shown below.

*If the quantification area is not positioned on the image after offset has been specified, it will be positioned out of the image area. Make sure to adjust the offset value so that the quantification area is within the image area.
1 Select Quant Result from the Windows menu.

Windows

- Image
- View
- Profile
- Info

Quant Result

- Profile/MW Result
- Distance Result
2.4 Profile/MW Mode

Line Profile Tool

The Line Profile tool is used to select (and display) a line segment from an image and measure its corresponding PSL profile.

1. Select the Line Profile tool ( ) from the tool box in Profile/MW mode.

2. When the cursor is placed inside the image, it will change to +. Place it on the top center of the lane and drag it over the desired region. Release the mouse button. (The line profile will be displayed in red.)

By dragging the rotation handle (red) with the Pointer tool, you can change the lane length and the angle. By dragging it with pressing the command key, only the angle can be changed.

Note: Drag the lane while holding down the shift key on the keyboard to draw a vertical or horizontal lane.

Select the Peak Aid from the Option submenu from the Analysis menu to display the Pak Aid display.
(See p. C-69, Peak Aid Function.)
Lane Profile Tool

This tool is used to connect 2 points on a lane of set width and measure the profile of the lane.

1 Select the Lane Profile tool ( ) from the tool box in Profile/MW mode.

2 When the cursor is placed inside the image, it will change to . Drag the cursor to one end of the lane and click.

By dragging the rotation handle (red) with the Pointer tool, you can change the lane length and the angle. By dragging it with pressing the command key, only the angle can be changed.

3 Double-clicking the created lane profile with the Pointer tool makes it possible to redo the width settings.

Double-click the on the tool box to display the Profile Width dialog and set the lane width prior to drawing lanes.
This tool is effective for setting a smiled lane.

1. Select the Smile Lane Profile tool (geführt) from the tool box in Profile/MW mode.

2. When the cursor is placed inside the image, it will change to the smile cursor. Place the smile cursor at the top of the lane and click.
3. Next, click the point on the profile you want to bend and then click the 3rd and 4th points and bands along the lane. End by double-clicking to finish setting the region. (The outline of the Smile Lane Profile will change to red.)

Note: By dragging the rotation handle (green) with the Pointer tool, you can change the angle.

4. By double-clicking the created Smile Lane Profile with the Pointer tool, you can redo the width settings.

Double-click the on the tool box to display the Profile Width dialog, making it possible to set the lane width prior to drawing lanes.
Start Line Tool

This tool can be used to align the starting lines when drawing a Profile Line for each lane.

1. Select the Start Line tool ( ) from the tool box in Profile/MW mode.

2. When the cursor is placed inside the image, it will change to X. Drag the mouse on the image from one point to another to display the start line you have created.
3. To create regions for the Line Profile, Lane Profile, and/or Smile Profile, by dragging from the start line, the starting points for each profile will be automatically aligned.

Note: If the profile region is moved after it has been created, it will be released from the start line. In addition, the start line cannot be moved or adjusted.
Automatic Lane/Band Tool

Automatically recognizes lanes, bands and/or BG within a specified area.

1. Select the Auto Lane/Band tool from the tool box in Profile/MW mode.

2. Place the crosshair at the starting point of the desired region and drag the mouse in the direction that the lane will unfold, to the end of the lanes. Release your finger from the mouse button. At this time, the direction will be determined by these two points -- the first point and the point at which you released the mouse button after dragging the mouse.
3 With your finger still off the mouse button, move the mouse. When you have enclosed the entire region of the lanes you want recognized, click the mouse. At this time, if you have enclosed too large an area, you will not be able to have the lanes correctly recognized.

Note: Up until you click the mouse button and define the region, you will be able to freely modify the size of the specified frame by using the point from which you began dragging as a fixed point.

4 The Profile Auto Lane & Band dialog will be displayed. Select each item as necessary.

Assign Lanes Evenly: Lanes of the same width are placed within a rectangle with the same amount of space between them. The lanes on both edges are positioned to touch the rectangle.

Find Lanes: Creates lanes by recognizing lane widths, numbers, and positions from the image.

Same Lane Width: Makes lane width even.

Lane Count: Input when the number of lanes has been set ahead of time.

Auto Peak Search: Automatically recognizes peaks (bands) in lanes.

Peak: Automatically recognizes peaks (bands) in each lane.

Peak & GB: Automatically recognizes peaks and backgrounds in each lane.
5 Click **OK**. The lanes, lanes and bands, or lanes, bands and BG in the specified region will be automatically recognized. (The following illustration is an example of automatic lane and band recognition.)
Band Tool

Specifies bands within lanes.

1. Select the Band tool, ✓, from the tool box in Profile/MW mode.

2. When the Mouse pointer is placed inside the image, it will change to (✗).
   Clicking the Mouse pointer above a band will mark that band.
Menu Functions Related to Profile/MW

Deleting Lane

The lane that has been quantified cannot be deleted, even pressing the delete key or selecting the Clear from the Edit menu. The following dialog will be displayed.

In this case, select the Delete Lane... from the Edit menu if you wish to delete the lane with the quantified result.
Setting Lane Width

The lane width for Lane Profiles and Smile Lane Profiles can be set as desired.

1. Select Lane Width... from the Option submenu from the Analysis menu.

2. The following dialog will be displayed. Input Profile width in terms the number of pixels and click OK. (You can also open this dialog by double-clicking the tool box with the Pointer.)
Setting the Peak ROI Type

Set the Peak ROI Type when using Auto Peak.

1. Select Peak Type... from the Option submenu of the Analysis Menu.

2. The following dialog will appear. Select the ROI type.

Point Peak: Recognizes Peak in units of 1 pixel.
Integrated Peak: Abstracts Peak from a certain width.
Peak Aid Function

Peak search functions using tools from Profile/MW and Distance modes and Profile line extensions functions are provided.

1. Select Peak Aid... from the Option submenu of the Analysis menu.

2. The following dialog will appear. Set the necessary items.

Use Peak Aid: When is clicked, a check mark will appear and this function will be available for use. At this time, PK Aid On will be displayed on the side of the tool box.

Search Area: With the point clicked with the mouse serving as the center, a fixed area is searched and the point on the highest peak is automatically determined. Set the number of pixels for the area of automatic search.

Profile Extend: When the Profile Line is specified and the center of the peak is selected, the distribution on the outside is not known. Here, this function can be used to automatically extend the Profile Line on both sides by “n%,” the value of which is input in the dialog.
Ex.: When Profile Extend is used (left) and when it's not (right)
Saving the Lane

1. Active (red) the lane on the image. (Multiple lanes can be selected.)

2. Select Export File from the File menu and then ROIs/Lanes... from the submenu.

3. Input the file name in the open dialog and specify the destination for saving.

4. The saved file will be displayed as the icon shown below.
Retrieving the Saved Lane

1. Select Import File from the File menu and then ROIs/Lanes from the submenu.

2. Specify the saved lane in the open dialog and open it.

3. The offset values can be specified in the Position dialog below.
In the saved lane, the position on the image when the lane was saved is stored.

For example, when retrieving the saved lane as shown at the left on a different image B, the lane will be positioned on Image B according to the image positioning conditions on Image A (at the 100 pixel/100 pixel position when viewed from the top left corner), assuming that Left offset: 0 pixel and Top offset: 0 pixel in the Position dialog.

When offset values are changed to Left: 50 pixels, Top: 50 pixels on the Image B in the Position dialog, the lane position will be shifted as shown below.
Displaying Profiles

1. Select Profile from the Windows menu.

The profile selected with the Profile tool will be displayed. There are 2 sub-modes (Display and Measure) in the Profile mode. The default setting is the Measure mode.
2.5 Distance Mode

Distance Tool

1. Select the Distance tool from the tool box in Distance mode.

2. When the cursor is placed inside the image, it will change to \(\frac{1}{2}\). Click the point on the image at which you want to begin measurement. Next, move the mouse to the first point that you want to measure (the measurement line will be displayed) and click.
4 To view (display) results of measurement, select Distance Result from the Windows menu.

<table>
<thead>
<tr>
<th>Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image</td>
</tr>
<tr>
<td>View</td>
</tr>
<tr>
<td>Profile</td>
</tr>
<tr>
<td>Info</td>
</tr>
<tr>
<td>Quant Result</td>
</tr>
<tr>
<td>Profile/MW Result</td>
</tr>
<tr>
<td>Distance Result</td>
</tr>
</tbody>
</table>

### Dist & Angle Result

<table>
<thead>
<tr>
<th>No.</th>
<th>Pt</th>
<th>Name</th>
<th>X1</th>
<th>Y1</th>
<th>X2</th>
<th>Y2</th>
<th>X3</th>
<th>Y3</th>
<th>Dist (mm)</th>
<th>Sum (mm)</th>
<th>Angle</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>Dist-1</td>
<td>210</td>
<td>359</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.00</td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td></td>
<td>214</td>
<td>415</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>11.23</td>
<td>11.23</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td></td>
<td>220</td>
<td>539</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>24.83</td>
<td>36.06</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>4</td>
<td></td>
<td>219</td>
<td>565</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>5.20</td>
<td>41.26</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>5</td>
<td></td>
<td>224</td>
<td>730</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>33.02</td>
<td>74.28</td>
<td></td>
</tr>
</tbody>
</table>
Interval Tool

This tool can be used to measure the distance between curves by using a parallel line that reaches between the two points you want to measure, allowing for accurate measurement of edges.

1. Select the Interval tool ( ) from the tool box in Distance mode.

2. When the mouse cursor is placed inside the image, it will change to . Click on the image the point at which you want to begin measurement. Next, move the mouse (the measurement line will be displayed) to the point at which you want to end measurement and click.
3 To view (display) the results of distance measurement, select Distance Result from the Windows menu.
Angle Tool

This tool can be used to measure any angle on an image.

1. Select the Angle tool (.Angle) from the tool box in Distance mode.

2. When the cursor is placed inside the image, it will change to -Angle-. Click 3 points on the image to create the angle that you want to measure.
3 To view (display) results of measurement, select Distance Result from the Windows menu.

<table>
<thead>
<tr>
<th>Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image</td>
</tr>
<tr>
<td>View</td>
</tr>
<tr>
<td>Profile</td>
</tr>
<tr>
<td>Info</td>
</tr>
<tr>
<td>Quant Result</td>
</tr>
<tr>
<td>Profile/MW Result</td>
</tr>
<tr>
<td>Distance Result</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Dist &amp; Angle Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>No.</td>
</tr>
<tr>
<td>-----</td>
</tr>
<tr>
<td>1</td>
</tr>
</tbody>
</table>
Part D

Analyzing Quantification Results
1. Analysis in Quant Mode

Selection of Displayed Items

Option - List

1. Select Quant Result from the Window menu. Quantification results will be displayed similarly to the following.

<table>
<thead>
<tr>
<th>No.</th>
<th>Index</th>
<th>Name</th>
<th>PGL</th>
<th>Area(cm)</th>
<th>Area of the measured region</th>
<th>Value with background subtracted</th>
<th>Ratio against the standard value</th>
<th>Value per 1mm²</th>
<th>Minimum pixel value in each ROI: converted value/pixel</th>
<th>Maximum pixel value in each ROI: converted value/pixel</th>
<th>Standard deviation against all the pixels in each ROI</th>
<th>Calibrated value</th>
<th>Known value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

2. You can select the items you want to have displayed when measurement results are displayed. Select List on the Option submenu from the Analysis menu.

Analysis

- Renumber
- Sort
- Calibration
- Data Info...
- Background
- Ratio Standard
- Distance Calibration...

Option

- Table
- List
3. A Quant List Item dialog like the following will be shown. By clicking the checked boxes, you can decide whether to display the items they represent or not.

<table>
<thead>
<tr>
<th>Quant List Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index</td>
</tr>
<tr>
<td>Group</td>
</tr>
<tr>
<td>Area Name</td>
</tr>
<tr>
<td>PSL</td>
</tr>
<tr>
<td>Area (mm²)</td>
</tr>
<tr>
<td>PSL-BG</td>
</tr>
<tr>
<td>Ratio</td>
</tr>
<tr>
<td>% of Group</td>
</tr>
<tr>
<td>PSL/Area</td>
</tr>
<tr>
<td>(PSL-BG)/Area</td>
</tr>
<tr>
<td>Min./Pixel</td>
</tr>
<tr>
<td>Max./Pixel</td>
</tr>
<tr>
<td>S.D./Pixel</td>
</tr>
<tr>
<td>Calibrated</td>
</tr>
<tr>
<td>Known Value</td>
</tr>
<tr>
<td>Information</td>
</tr>
</tbody>
</table>

Click the Quant List box to display the Quant List Item dialog.
Dividing Measured Regions into Groups

Depending on the experiment method, it is possible to divide the entire region to be measured into groups of regions based on differences in factors (conditions) and display them.

1. While holding down the Command key, click (and thus define) the measurement Nos. that you want to form into one group. At this time, as long as the position clicked is something other than Area Name, you can click anywhere within the line for the region.

**Method 1**
To select multiple consecutive measurement Nos. at one time, click the top measurement No. you want to select. Then, while holding down the shift key, click the last of the Nos. you want to select. The Nos. in between the two that were clicked will all be selected.

**Method 2**
Drag the mouse to anywhere except the Area Name column. The measurement Nos. for the area thus specified will be selected.
2 Select Group from the Edit menu.

3 The regions that have been divided into groups will be shown on the bottom lines of the Quant Result table. In the group column, the group name will be displayed (name will be a letter; "A" in the following example).

4 To undo the grouping, select the measurement No. and then select Ungroup from the Edit menu.
Procedure for assigning a new measurement No. to a group that has already been selected

1. Select the measurement No. that you wish to add and drag it with the mouse.

2. Place the cursor in the space for the measurement number of the group that you wish to add, hold down the Command key (⌘) and then release the mouse button. The dragged measurement No. will be added to that group.
Quant Result Operations

(1) Background Subtraction

When the sample undergoes exposure, background noise always manages to enter. If this background noise is not eliminated (subtracted), sample data cannot be accurately measured. Thus, an ROI for measuring the background is created and that value is subtracted and displayed.

Note: Subtraction is done by multiplying the background around the unit area by the area of the sample data.

(1)-1 When there is no group division

1. Click the measurement No. of the background region in the Quant Result table to select it. (Here, "10" will be used as an example.)

<table>
<thead>
<tr>
<th>No.</th>
<th>Index</th>
<th>% of Group</th>
<th>% of Area</th>
<th>PSL</th>
<th>Meas. ppm</th>
<th>% of PSL</th>
<th>PSL ppm</th>
<th>PSL ppm</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
<td>104.60</td>
<td>1598.00</td>
<td>16.77</td>
<td>24.98</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>2</td>
<td>23.13</td>
<td>935.00</td>
<td>10.74</td>
<td>43.51</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>3</td>
<td>20.83</td>
<td>1940.00</td>
<td>21.26</td>
<td>56.89</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>4</td>
<td>4</td>
<td>24.49</td>
<td>1940.00</td>
<td>25.19</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>5</td>
<td>5</td>
<td>39.24</td>
<td>891.50</td>
<td>9.76</td>
<td>23.91</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>6</td>
<td>6</td>
<td>25.16</td>
<td>749.50</td>
<td>8.83</td>
<td>31.92</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>7</td>
<td>7</td>
<td>24.45</td>
<td>2117.00</td>
<td>22.82</td>
<td>44.43</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>9</td>
<td>9</td>
<td>100.00</td>
<td>510.20</td>
<td>10.00</td>
<td>10.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>10</td>
<td>62.99</td>
<td>15.25</td>
<td>0.17</td>
<td>0.25</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>11</td>
<td>11</td>
<td>62.99</td>
<td>15.25</td>
<td>0.15</td>
<td>0.14</td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>12</td>
<td>12</td>
<td>12.37</td>
<td>89.60</td>
<td>12.37</td>
<td>0.15</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

2. Select Local from the Background submenu of the Analysis menu.

Local: For setting background within the same group only.
Global: For setting background for all groups (or all the regions).
The specified background value will be subtracted from all the regions (bands) and the PSL-BG value will automatically be displayed on the Quant Result table.

In the Quant Result table, in the left half of the Info column of a row in which background was set, a [B] will be displayed to indicate that that region is a background.

**Note:** When no background has been specified, PSL-BG will be displayed with BG=0.

### Quant Result

<table>
<thead>
<tr>
<th>No</th>
<th>Index</th>
<th>G</th>
<th>Area Name</th>
<th>PSL</th>
<th>Area (mm²)</th>
<th>PSL-BG</th>
<th>% of Grp</th>
<th>PSL int/2</th>
<th>Info</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>—</td>
<td>-</td>
<td></td>
<td>1549.00</td>
<td>44.28</td>
<td>1535.00</td>
<td>16.81</td>
<td>34.90</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>—</td>
<td>-</td>
<td></td>
<td>935.60</td>
<td>22.12</td>
<td>931.90</td>
<td>16.17</td>
<td>40.51</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>—</td>
<td>-</td>
<td></td>
<td>1013.00</td>
<td>26.30</td>
<td>1035.00</td>
<td>11.31</td>
<td>50.00</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>—</td>
<td>-</td>
<td></td>
<td>639.60</td>
<td>24.48</td>
<td>635.70</td>
<td>9.00</td>
<td>30.14</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>—</td>
<td>-</td>
<td></td>
<td>611.50</td>
<td>30.24</td>
<td>604.10</td>
<td>9.77</td>
<td>20.81</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>—</td>
<td>-</td>
<td></td>
<td>750.50</td>
<td>22.15</td>
<td>709.40</td>
<td>6.65</td>
<td>31.62</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>—</td>
<td>-</td>
<td></td>
<td>2107.00</td>
<td>24.98</td>
<td>2101.00</td>
<td>22.90</td>
<td>84.41</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>—</td>
<td>-</td>
<td></td>
<td>2107.00</td>
<td>24.98</td>
<td>2101.00</td>
<td>22.90</td>
<td>84.41</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>—</td>
<td>-</td>
<td></td>
<td>510.20</td>
<td>15.40</td>
<td>506.50</td>
<td>5.72</td>
<td>33.13</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>—</td>
<td>-</td>
<td></td>
<td>450.50</td>
<td>12.20</td>
<td>477.30</td>
<td>7.22</td>
<td>36.41</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>—</td>
<td>-</td>
<td></td>
<td>12.07</td>
<td>0.00</td>
<td>—</td>
<td>—</td>
<td>0.14</td>
<td></td>
</tr>
</tbody>
</table>

(1)-2 When there is group division

It is possible to apply to all the groups one background that does not belong to any of them. However, if a background within a group has already been set, this cannot be done. Also, the last background set within a group will take priority.

1. Click the measurement No. of the background region in the Quant Result table that you want to use for all groups to select it (*10* in this example).
2. Select Global on the Background submenu from the Analysis menu.

3. When Global is selected, will be shown in the Info column.

Note: When multiple backgrounds have been set, the average value for them can be applied as a background (for both Local and Global).
4 As shown in the following example, when a background has been set within a group (here, measurement No. 11 has been set in Group A), that background will be given priority.

5 To undo a background, select the measurement No. that you want to undo and then select None on the Background submenu from the Analysis menu.

(2) Setting a Standard

A sample you want to quantify and an already quantified (known) standard can be exposed on the same IP. The value for each measured region can be displayed as a ratio of the value of the measured standard.

(2)-1 Setting a Standard when there is no group division

1 From the Quant Result table, click to select the measurement No. of the standard to be used for quantification (here, measurement No. 9 has been set as a standard).

(Multiple standards cannot be set.)
2. Select Ratio Standard from the Analysis menu.

The value for the specified standard will be set at 100 for each group. The value for other regions will be recalculated in kind. The revised values will automatically be displayed in the Ratio column in the Quant Result table. Also, in the right half of the Info column on the line where the standard was set, an $\text{S}$ will be displayed to indicate that region is the standard.

```
<table>
<thead>
<tr>
<th>No.</th>
<th>G</th>
<th>PSL</th>
<th>Area (mm2)</th>
<th>PSL-BG</th>
<th>Ratio</th>
<th>% of Grp</th>
<th>(P-B)/mm2</th>
<th>Info</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A</td>
<td>1652.00</td>
<td>52.20</td>
<td>1652.00</td>
<td>_____</td>
<td>56.67</td>
<td>31.65</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>A</td>
<td>1263.00</td>
<td>43.40</td>
<td>1263.00</td>
<td>_____</td>
<td>43.33</td>
<td>29.10</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>1429.00</td>
<td>39.68</td>
<td>1429.00</td>
<td>120.38</td>
<td>13.57</td>
<td>35.00</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>2648.00</td>
<td>48.94</td>
<td>2648.00</td>
<td>223.12</td>
<td>25.16</td>
<td>54.21</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>-</td>
<td>1075.00</td>
<td>42.92</td>
<td>1075.00</td>
<td>90.62</td>
<td>10.22</td>
<td>25.06</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>-</td>
<td>2495.00</td>
<td>45.60</td>
<td>2495.00</td>
<td>210.24</td>
<td>23.70</td>
<td>54.71</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>-</td>
<td>853.30</td>
<td>44.80</td>
<td>853.30</td>
<td>71.90</td>
<td>8.11</td>
<td>19.05</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>-</td>
<td>839.20</td>
<td>34.72</td>
<td>839.20</td>
<td>70.72</td>
<td>7.97</td>
<td>24.17</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>-</td>
<td>1187.00</td>
<td>40.60</td>
<td>1187.00</td>
<td>100.00</td>
<td>11.27</td>
<td>29.23</td>
<td></td>
</tr>
</tbody>
</table>
```
Setting a Standard for Each Group

1. Divide the regions in the Quant Result table into groups. (See p. D-4, Dividing Measured Regions into Groups, Group.)

2. In the Quant Result table, for each group click to specify the standard to be used for quantification and select Standard from the Analysis Menu.

The value for each specified standard will be set at 100 for each group. The value for other regions (bands) for each group will be recalculated in kind. The revised values will automatically be displayed in the Ratio column in the Quant Result table. Also, in the right half of the Info column on the line where the standard was set, an \( S \) will be displayed to indicate that that region is the standard.

<table>
<thead>
<tr>
<th>No.</th>
<th>G</th>
<th>PSL</th>
<th>Area (mm²)</th>
<th>Ratio</th>
<th>% of Grp</th>
<th>Ratio : PSL</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A</td>
<td>1428.00</td>
<td>38.48</td>
<td>109.25</td>
<td>36.23</td>
<td>37.10</td>
</tr>
<tr>
<td>2</td>
<td>A</td>
<td>1206.00</td>
<td>40.32</td>
<td>92.26</td>
<td>30.60</td>
<td>29.90</td>
</tr>
<tr>
<td>3</td>
<td>A</td>
<td>1307.00</td>
<td>31.28</td>
<td>100.00</td>
<td>33.17</td>
<td>41.78</td>
</tr>
<tr>
<td>4</td>
<td>B</td>
<td>2313.00</td>
<td>38.48</td>
<td>113.01</td>
<td>42.97</td>
<td>60.11</td>
</tr>
<tr>
<td>5</td>
<td>B</td>
<td>1023.00</td>
<td>40.32</td>
<td>49.99</td>
<td>19.01</td>
<td>25.37</td>
</tr>
<tr>
<td>6</td>
<td>B</td>
<td>2047.00</td>
<td>31.28</td>
<td>100.00</td>
<td>38.02</td>
<td>65.43</td>
</tr>
<tr>
<td>7</td>
<td>C</td>
<td>825.90</td>
<td>38.48</td>
<td>78.57</td>
<td>29.81</td>
<td>21.46</td>
</tr>
<tr>
<td>8</td>
<td>C</td>
<td>893.60</td>
<td>40.32</td>
<td>85.01</td>
<td>32.25</td>
<td>22.16</td>
</tr>
<tr>
<td>9</td>
<td>C</td>
<td>1051.00</td>
<td>31.28</td>
<td>100.00</td>
<td>37.94</td>
<td>33.61</td>
</tr>
<tr>
<td>10</td>
<td>D</td>
<td>1207.00</td>
<td>38.48</td>
<td>161.17</td>
<td>43.27</td>
<td>31.37</td>
</tr>
<tr>
<td>11</td>
<td>D</td>
<td>833.80</td>
<td>40.32</td>
<td>111.31</td>
<td>29.88</td>
<td>20.68</td>
</tr>
<tr>
<td>12</td>
<td>D</td>
<td>749.10</td>
<td>31.28</td>
<td>100.00</td>
<td>26.85</td>
<td>23.95</td>
</tr>
<tr>
<td>13</td>
<td>-</td>
<td>1175.00</td>
<td>40.32</td>
<td>—</td>
<td>100.00</td>
<td>29.15</td>
</tr>
</tbody>
</table>
(3) **Shortcuts for Setting Groups, Backgrounds, and Standards**

1. With one measurement No. selected, select Date Info... from the Analysis menu. The following About This Quant dialog will be displayed.

```
<table>
<thead>
<tr>
<th>No</th>
<th>Memo</th>
<th>Group</th>
<th>Background</th>
<th>Standard</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td>None</td>
<td></td>
</tr>
</tbody>
</table>
```

Each item in this dialog can be set.

- **No.** Displays the measurement No. currently selected. When regions are erased and measurement Nos. are freed up in kind, this function can be used to reassign Nos.
- **Area Name box** For inputting the characters that will display the Area Name. (Will be displayed as the Area Name for Quant Result.)
- **Memo** For inputting information for each measurement No. (Will not be displayed in Quant Result.)
- **Group** For changing group assignments.
- **Background** None, Local, or Global can be set.
- **Standard** Check to set the standard.

1. **Double-click the measurement No. to display the About This Quant dialog.**

2-1 **By double-clicking the data information (left and right sides of the Info column) for the measurement No., the Local background and standard can be set.**

2-2 **Click [B] while holding down the shift key to make Local and Global selections.**
(4) Setting Reference Values

1. It is possible to modify the standard values for % of Grp and Ratio. Select Table on the Option submenu on the Analysis menu.

![Analysis Options]

2. Click to select each item that you want to set for the image.

![Quant Result Table]

Note: On the Result window, the selected Ratio will be shown in red and the selected % of Grp will be shown in green. When the same item for the image is used, that item will be shown in light blue.
(5) Setting the Calibration Curve

Create a calibration curve from the quantification results.

1. Create the ROI you will use with the calibration curve.

2. From Quant Result, click to select the data you will use for the calibration curve. To select multiple pieces of data, click the appropriate measurement Nos. while holding down the Command key (⌘).
3 Select New... on the Calibration submenu on the Analysis menu.

![Diagram of Analysis and Calibration menu]

**Analysis**
- Renumber
- Sort

**Calibration**
- Data Info...
- Background
- Ratio Standard
- Distance Calibration...
- New...
- Show...

**Option**
4. A Density Calibration dialog like the following will be displayed. Here, you can input the known values of each quantification result and set other items.

It is possible to save as a file the known values input using Save... and to recall them using Load...

- **Convert Method:**
  - Volume
  - Density
  - Set the total volume for reference.
  - Density
  - Set the measured value/pixel for reference.

- **Measured:**
  - PSL
  - PSL/BG
  - PSL/Area
  - (PSL- BG)/Area
  - Select the unit (value) for conversion.

- **Convert Function:**
  - \[ y = a + bx \]
  - \[ y = e^x \]
  - \[ y = ax^2 + bx + c \]
  - \[ y = ax^3 + bx^2 + cx + d \]
  - \[ y = e^x - b \]
  - \[ y = Log(x) - b \]
  - Select the convert function

- **Scale Measured(X):**
  - Linear
  - Log
  - Select the unit for the X-axis.

- **Scale Known(Y):**
  - Linear
  - Log
  - Select the unit for the Y-axis.

- **Unit:**
  - Calibrated
  - Arbitrary numeric input column.
5 Click Curve Fit to draw the curve.

6 Lastly, click Apply. The values in Quant Result will be converted based on the calibration curve created. Here, the measured values for the image will have undergone calibration.
7 Select Show on the Calibration submenu on the Analysis menu. The current calibration curve dialog will be displayed. This calibration curve cannot be updated, but saving and/or printing are possible. Click OK to close the display.
2. Analysis in Profile/MW Mode

Displaying the Profile Line

When Profile is selected from the Windows menu in Profile mode, a Profile line like the following will be displayed.

Profile mode has the following two submodes.

- **Display**: For modifying the graph display method.
- **Measure**: For taking measurements from the graph.

To switch between modes, use the Mode pulldown menu.
2.1 Display Mode
(Including common tools)

Sequential Switcher

When multiple profiles exist, they can be switched between in order of the profile numbers that have been assigned to them. Each time the ▼ ▲ are clicked, the number of the profile for display will change.

Pulldown Switcher

1 Select the profile number from the pulldown menu on the tool box.

2 In Display mode, it is possible to display multiple profiles at one time. Select Select... from the pulldown menu.
3. The Select Profiles dialog will be displayed. Click the profiles you wish to display at one time to select them and end by clicking OK.

4. The selected profiles will be selected all at one time (only in Display mode).

Note: In step 3, above, before clicking OK, it is possible to change the display color by using the Profile Color pulldown menu from the Select Profiles dialog.

At this time, there will be only one selected profile (shown with a solid line). The others will appear as unselected (shown with a broken line). To change selection, use the Pointer tool. It is also possible to use Measure mode on a selected profile.
Pointer Tool

Select an object (or more than one) created with an analysis tool. It is also possible to select a graph itself.

Graph Slider Tool

This tool is used to slide the graph horizontally.

1. Select the [ ] within the graphed region and drag it to slide the graph.

To return a moved graph to its original position, double-click the [ ] on the tool box.
Horizontal Magnifying Glass Tool

This tool is used to magnify the graph horizontally without changing the height value.

1. Select and click a point within the graphed region. (With the clicked point serving as the center, the graph will be magnified to twice its size.)

2. To reduce the graph, hold down the shift key and click.

Double-click the on the tool box to restore the profile to its original state.

Quick
Vertical Magnifying Glass Tool

This tool is used to magnify the graph vertically without changing the width value.

1. Select and click a point within the graphed region. (With the clicked point serving as the center, the graph will be magnified to twice its size.)

2. To reduce the graph, hold down the shift key and click.

*Double-click the on the tool box to restore the profile to its original state.*
Magnifying Glass Tool

This tool is used to magnify the graph (horizontally and vertically).

1. Select the magnifying glass icon and click a point within the graphed region. (With the clicked point serving as the center, the graph will be magnified to twice its size.)

2. To reduce the graph, hold down the shift key and click.

   Double-click the on the tool box to restore the profile to its original state.

Hand Tool

This tool is used to move (scroll) region of the image displayed.
Select the hand icon and then drag the mouse pointer on the image.

Double-click the on the tool box to restore the profile to its original state.
2.2 Measure Mode

Horizontal BG Tool

Creates a horizontal BG (background) on the Profile.

1 With the Profile window in Measure mode, select the Horizontal BG tool from the tool box.

2 When you place the pointer within the graphed region, it will change to . At this time, the PSL value of the BG line will be displayed in realtime on the right side of the tool box, in keeping with the movement of .
3 Moving the mouse, move the Pointer to a background position and click to set.

4 By selecting Copy BG Line... from the Analysis menu, the horizontal BG line created here can be copied and applied to another profile.
If you double-click the Horizontal BG tool, the Profile Background dialog will be displayed and the BG line will be set in accordance with the input value.
### 2.2 Measure Mode

**Background Tool**

This tool is used to set the background level of a graph.

1. Select the tool from the tool box in Measure mode.

2. When the mouse pointer is placed within the graphed region, its shape will change as shown below.
3 On the first peak, click what will be the starting point for the background level (the upright portion). Then, move the mouse from point to point (they will be connected with a straight line), clicking as you go.

4 Double-click the last point.
5 To erase the background, select Clear BG Line... from the Analysis menu.

Note: The background that can be set for one profile is limited to one line. Also, by dragging the handle on the line with the Pointer tool, you can freely change the position.
Spline BG Tool

Creates a smooth BG (background) line on the profile.

1. With the Profile window in Measure mode, select the Spline BG tool, \(BG\), from the tool box.

2. Below, a background is created following the same procedure as when the background tool is used.
2.2 Measure Mode

Integral Tool

This tool is used for measuring a portion from which the background created with the Background tool has been eliminated.

1. Select the Integral tool, ( ), from the tool box in Measure mode.

2. When the mouse pointer is placed within the graphed region, its shape will change as shown below.
3 Measure by dragging the graphed portion (peak) that you want to measure and releasing the mouse.

4 Measure each peak by dragging it.

5 Refer to Displaying Profile Results, p.D-53.

Note: With the Pointer tool, you can freely change the left and right edges of a peak.
Measure Profile Tool

This tool is a combination of the Background and Integral tools.

1. Select the Measure Profile tool, ( ), from the tool box in Measure mode.

2. When the mouse pointer is placed within the graphed region, its shape will change as shown below.
3 Drag from the starting point of the background level on the first peak (the upright portion) to the next point (they will be connected with a straight line), release the mouse button there, and measuring will be done.

4 Measure each peak by dragging it.

5 Refer to Displaying Profile Results, p. D-53.

Note: When peaks have been deleted and added, select Renumber from the Analysis menu to renumber the measurement Nos. for the profile graphs in order from the left side.
Density Picker Tool

This tool is used to measure the value of one pixel on the graph.

1. Select the Density Picker, ( ), from the tool box in Measure mode.

2. When the mouse pointer is placed within the graph, its shape will change as shown below. At this time, the distance and the value for one pixel will be displayed in realtime beside the tool box.
3 Click each peak you want to measure. (The value for the position of the cursor will be measured.)

4 Refer to Displaying Profile Results, p. D-53.
2.2 Measure Mode

Automatic Profile Background Recognition

Auto BG...

Automatically creates the background suitable for the smear components from the profile.

1. With the Profile window in Measure mode, select Option from the Analysis menu and then select Auto BG... from the submenu.

2. The Auto Background dialog will be displayed. In the input columns, input the parameters for background recognition.
Lowest (Horizontal Line)

Creates a horizontal BG line from the minimum value on the profile.

Valley (Polygonal Line)

H. Ratio (A/B): %
V. Ratio (C/D): %

Creates an arbitrary BG line when the parameters for the horizontal and vertical directions are input (set).

H. Ratio (A/B): Parameter set for the horizontal direction

The parameter (% value) input here becomes the standard value when the created profile's total length (in the horizontal direction) is taken to be 100%. The smaller % value becomes, the more valleys are detected.

Example: As shown in the following illustration, when the interval between valleys is 10% of the total length, BG line "A" will be drawn if this parameter is set to under 10%. If it is set to 10% or more, BG line "B" will be drawn.

(However, in this example, the influence of the parameter for the vertical direction has not been considered.)
2.2 Measure Mode

V. Ratio (C/D): Parameter set for the vertical direction

The parameter (% value) input here becomes the standard value when the maximum amplitude of the created profile (in the vertical direction) is taken to be 100%. The smaller % value becomes, the more valleys are detected.

Example: As shown in the following illustration, when the interval between the valley and the maximum value is 70% for the maximum amplitude, BG line “A” will be drawn if this parameter is set to under 70%. If it is set to 70% or more, BG line “B” will be drawn.

(However, in this example, the influence of the parameter for the horizontal direction has not been considered.)

Valley (Spline)

Subtracts a smooth background line.

H. Ration (A/B) and V. Ratio (C/D) are the same as Valley (Polygonal Line).
3. After inputting the parameters, click **OK** on the Auto Background dialog.

4. With the Profile window in Measure mode, select BG Search from the Analysis menu.

<table>
<thead>
<tr>
<th>Analysis</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Renumber</td>
<td></td>
</tr>
<tr>
<td>Data Info</td>
<td></td>
</tr>
<tr>
<td>Peak Search...</td>
<td></td>
</tr>
<tr>
<td><strong>BG Search</strong></td>
<td></td>
</tr>
<tr>
<td>Copy BG Line...</td>
<td></td>
</tr>
<tr>
<td>Clear BG Line...</td>
<td></td>
</tr>
<tr>
<td>Copy RF Ratio...</td>
<td></td>
</tr>
<tr>
<td>Option</td>
<td></td>
</tr>
</tbody>
</table>
A background line like the following will be automatically created in accordance with the set parameters.

Note: When the Pointer is used to specify the valley point (when the Pointer is \( \square \)) and the 9 key is pressed, the Pointer will change to \( \blacktriangledown \). In this condition, if you drag the mouse, the BG point will be copied. If you press the shift key, the Pointer will change to \( \blacktriangleleft \). If you click the mouse in this condition, the BG point will be deleted.
Automatic Recognition of a Profile Measurement Region

Peak Search

It is possible to automatically set a Profile measurement region.

1. In Measure mode, select Peak Search... from the Analysis menu.

The following dialog will appear.

Peak : Peak will be recognized automatically.
Peak & BG : Peak and BG will be recognized automatically.
2. Similar to the following illustration, a measurement region for the peak and BG will be automatically set.

![Graph showing measurement region](image1)

3. Select the Pointer tool from the tool box. By dragging the broken line on the region, you can make fine adjustments on the enclosure.

![Graph showing fine adjustments](image2)

**Note:** When peaks have been deleted and added, select Renumber from the Analysis menu to renumber the measurement Nos. for the profile graphs in order from the left side. When used together with the background tool, measurement is also possible.

4. Refer to Displaying Profile Results, p. D-53.
Setting Rf

Rf expresses the positional relationship substance found with thin layer chromatography, which is calculated as a fraction.

\[
Rf = \frac{\text{Distance from origin to substance}}{\text{Distance from origin to solvent front}}
\]

1. Select Measure mode.

2. In Measure mode, drag the Rf normalizer and move from the origin of the lane to the front. When this has not been designated, from the starting point to the end point of the profile line will be selected.

3. Perform quantification.
   Especially when using the Density Picker tool, it is possible to define points.
   (When a uniform interval has been specified, the center of the largest peak will be the point.)
Measuring Distance Using the Rf Value
Mode Used: Profile - Measure
Function Overview: Measures distance in accordance with the Rf normalizer.

With the Profile window in Measure mode, by setting the Rf normalizer, the distance display can be measured so that the X-coordinate of the origin is always 0, no matter where it is moved.
An example of moving the X-coordinate by using the Rf normalizer follows.

4 When Profile/MW Result is selected from the Windows menu, Rf will be displayed.
Applying the Rf Value

Copy RF Ratio

It is possible to apply to another profile the distance between the front and the origin of the Rf set for one measured lane from a profile.

1 Set the Rf that will serve as the standard.

2 Display another profile lane and set only the origin.

*Note: Using the Start Line tool to set the origin makes operations easier.*
3. Redisplay the profile serving as the standard and select Copy RF Ratio... from the Analysis menu.

4. Click YES to apply the standard distance to other lane(s).
Setting the Profile Display Method

1. Select Display... on the Option submenu from the Analysis menu.

2. The following Profile Display dialog will be displayed. After setting each item, click OK.
Displaying Profile Results

1. Select Profile/MW Result from the Windows menu.

<table>
<thead>
<tr>
<th>Windows</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Image</td>
<td>361</td>
</tr>
<tr>
<td>View</td>
<td>362</td>
</tr>
<tr>
<td>Profile</td>
<td>363</td>
</tr>
<tr>
<td>Info</td>
<td>364</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Quant Result</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile/MW Result</td>
<td>365</td>
</tr>
<tr>
<td>Distance Result</td>
<td>367</td>
</tr>
</tbody>
</table>

2. A Profile Result table similar to the following will be displayed.

<table>
<thead>
<tr>
<th>No.</th>
<th>Len</th>
<th>Area Name</th>
<th>PCL</th>
<th>PCL-EG</th>
<th>Flock</th>
<th>% of Lane</th>
<th>Dist (mm)</th>
<th>RF</th>
<th>Dir</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td></td>
<td>19.91</td>
<td></td>
<td></td>
<td></td>
<td>6.23</td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td></td>
<td>40.96</td>
<td></td>
<td></td>
<td></td>
<td>3.85</td>
<td>0.07</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td></td>
<td>44.91</td>
<td></td>
<td></td>
<td></td>
<td>11.85</td>
<td>0.15</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>1</td>
<td></td>
<td>48.80</td>
<td></td>
<td></td>
<td></td>
<td>25.25</td>
<td>0.32</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>1</td>
<td></td>
<td>47.81</td>
<td></td>
<td></td>
<td></td>
<td>52.85</td>
<td>0.81</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>1</td>
<td></td>
<td>58.60</td>
<td></td>
<td></td>
<td></td>
<td>56.75</td>
<td>0.89</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>1</td>
<td></td>
<td>64.40</td>
<td></td>
<td></td>
<td></td>
<td>72.75</td>
<td>0.94</td>
<td></td>
</tr>
</tbody>
</table>
2.2 Measure Mode

Molecular Weight Measurement

Molecular weight is measured from the distance of phoresis.

1. Set the lanes and bands within lanes in the sample.

Recognition of these lanes and bands can be done either automatically or manually.

When automatic recognition is set:
   See C-62 for the method for using the Auto Lane/Band tools.

When manual recognition is set:
   After lane setting with the Lane Profile tool (see C-67) or automatic recognition of lanes only has been set, set with the Band tool (see C-65).
2 Set the lane that will serve as the standard. After clicking on the image the lane that will be the standard (multiple lanes can also be selected), select Set... from the Lane Standard submenu of the Analysis menu.

3 The following dialog will be displayed.
4. Input the known molecular weights for each band in the MW column. Select the function to be used from the Convert Function column.

<table>
<thead>
<tr>
<th>Distance</th>
<th>MW</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>26.00</td>
</tr>
<tr>
<td>2</td>
<td>51.00</td>
</tr>
<tr>
<td>3</td>
<td>99.00</td>
</tr>
<tr>
<td>4</td>
<td>154.00</td>
</tr>
<tr>
<td>5</td>
<td>193.00</td>
</tr>
<tr>
<td>6</td>
<td>230.00</td>
</tr>
<tr>
<td>7</td>
<td>285.00</td>
</tr>
<tr>
<td>8</td>
<td>325.00</td>
</tr>
<tr>
<td>9</td>
<td>360.00</td>
</tr>
<tr>
<td>10</td>
<td>427.00</td>
</tr>
<tr>
<td>11</td>
<td>471.00</td>
</tr>
<tr>
<td>12</td>
<td>540.00</td>
</tr>
<tr>
<td>13</td>
<td>605.00</td>
</tr>
<tr>
<td>14</td>
<td>655.00</td>
</tr>
<tr>
<td>15</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td></td>
</tr>
<tr>
<td>19</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td></td>
</tr>
</tbody>
</table>

After setting the conditions, click **Curve Fit**. A calibration curve will be created.
If OK is clicked, along with a display (as in the following figure) of based on already known molecular weights, the unknown molecular weights will be measured from the calibration curve.

If Profile/MW Result is selected from the Windows menu, the measurement results will be displayed.
3. Related Menu Functions (used in both Quant and Profile)

3.1 Modifying the Unit

It is possible to change the unit for quantification used on the display or in the Result window, etc..

1. Select Density... on the Preferences submenu from the File menu.

2. The following Density dialog will be displayed. Each item can be set and the desired unit used.

* For the unit name, up to 3 English letters can be input.
3.2 Making Quantification Results into a File

1. Activate the Result window that you want to save (status of 6 parallel lines displayed on the title bar on the front screen of the desktop). The values for the items displayed at this time will be saved.

<table>
<thead>
<tr>
<th>No.</th>
<th>PQL</th>
<th>Area (p&lt;0)</th>
<th>PQL (Q)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1057.00</td>
<td>655</td>
<td>1057.00</td>
</tr>
<tr>
<td>2</td>
<td>721.00</td>
<td>455</td>
<td>721.00</td>
</tr>
<tr>
<td>3</td>
<td>699.00</td>
<td>551</td>
<td>699.00</td>
</tr>
<tr>
<td>4</td>
<td>787.00</td>
<td>646</td>
<td>787.00</td>
</tr>
<tr>
<td>5</td>
<td>364.20</td>
<td>420</td>
<td>364.20</td>
</tr>
<tr>
<td>6</td>
<td>1282.00</td>
<td>524</td>
<td>1282.00</td>
</tr>
<tr>
<td>7</td>
<td>679.50</td>
<td>551</td>
<td>679.50</td>
</tr>
</tbody>
</table>

2. Select TEXT... on the Export File submenu from the File menu.

3. When the file name and save destination is selected, a file will be formed (in TEXT format) and the following icon will appear.

```
Quant Result.text
```
3.3 Copying & Pasting

It is possible to copy and paste the Result window (or Profile window) onto the image.

1. Activate the Result window. Here, make sure no measurement No. has been selected in the window.

2. Select Copy from the Edit menu. (The window will be stored on the clipboard.)

3. In Annotation mode, activate the image window and paste in the Result window.
3.4 Changing the Position of the Measurement No.

1. Select the measurement No. that you want to move and drag it to the desired position.

2. While moving the No., if you release the mouse button while holding down the shift key, the No. for the place at which you released the mouse and the No. you are moving will switch places.
3.4 Changing the Position of the Measurement No.
Part E

Printing
With Image Gauge Ver. 4.0, printing can be done with the laser beam printer and the PG3000, PG3500, PG4000 or PSD400 high-resolution output printer (option) connected to the Macintosh.

1. Printing an Image

Images controlled by this software or entire screen can be printed out through the laser beam printer or the PG3000, PG3500, PG4000 or PSD400 printer.

1.1 Printing with a Laser Beam Printer

1. Activate the image window that you want to print (6 parallel lines will be displayed on the window title bar in front of the desktop).

2. Select Print... from the File menu. The following Print dialog will be displayed. At this time, the image window will be printed out as it is (although modifications are possible).
3 Select Positioning or Trimming. (The initial setting is Positioning.)

Positioning  Designate the layout for the paper used in printing.
When the centering box is clicked, the image will be printed at the same size in the center of the paper. However, by dragging the entire image, you can freely change where it will be printed.
When size is modified via Scale: %, the size that the image is printed out will be modified. (When 100% is set, the image will be printed at its actual size.) See page E-6 for printing at actual size of an image captured from an external device (images read by other than the IP Reader or Fluorescent Reader).

Trimming  Designate (trim) the region of the image that will be printed. (Initially, the state of the image window will be displayed.)

Note: To position an image that has been trimmed, after designating the region to be printed, switch back again to Positioning.
Page Set Up... Select the paper size.

It is possible to print out with the image the objects made with each mode. Select the mode that has object in Information: options. Selected mode will be checked (✓).

<table>
<thead>
<tr>
<th>Information:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Annotation</td>
<td></td>
</tr>
<tr>
<td>Quant</td>
<td></td>
</tr>
<tr>
<td>Profile</td>
<td></td>
</tr>
<tr>
<td>Distance</td>
<td></td>
</tr>
</tbody>
</table>

Annotation  For printing out with the image the objects made in Annotation mode.
Quant        For printing out with the image the objects made in Quant mode.
Profile      For printing out with the image the objects made in Profile mode.
Distance     For printing out with the image the objects made in Distance mode.

* A multiple number of modes can be selected.
4 When Options... is clicked, the following Printout Options dialog will be displayed. After setting the necessary items, click OK.

- **Comment**: For putting a comment at the edge of the image region.
  - None: When no comment is needed.
  - Top: Puts the input comment at the top.
  - Bottom: Puts the input comment at the bottom.

- **CLUT**: Puts the Color Look Up Table at the edge of the image area.
  - None: When no CLUT is needed.
  - Top: Puts the CLUT at the top end.
  - Bottom: Puts the CLUT at the bottom end.

- **Back**: Specifies background color for the comment and CLUT.
  - None: When no background color is needed.
  - White: Specifies white for background color.

- **Printer Quality**: Determines output pixel size. (Image quality will be changed.)
  - Best: Applies image pixel size to output. (Results in attractive output but printing time is long.)
  - Better: Prints images at standard pixel size (with pixels thinned out by 1/4).
  - Good: Prints images with pixels thinned out by 1/16. (Output is coarse, but printing time is short.)
  - Auto: Prints images at best quality under memory environments assigned to software at time of printing. Pixels will be thinned out gradually. Printing will not be possible if memory capacity is not sufficient even though pixels have been thinned out by 1/16.

- **Adjust Width/Height**: Allow actual output size to be finely adjusted in increments of 0.1%.

5 When you click OK in the Print dialog, the setting dialog for the attached printer drive will be displayed. Set the necessary items and print.
Printing in actual size an image captured from an external device (images read by other than IP Reader/Fluorescent Reader)

By adding distance information to an image, it is possible to print the image in actual size captured by an external device.

1. Open the target image and change mode to Distance. Measure the distance between specified points (where the actual distance is known) and then display the result table.
2 Activate the result table and select Distance Calibration... from the Analysis menu.

3 When the following display appears, input the known distance in the Known Length box.
4 Select Print... from the File menu to display the Print dialog.

5 Select Use for Calibrated in the Print dialog below.

It is thus possible to print the image with the calibrated distance. If Scale is set to 100%, actual size printing is possible.
(2) Screen Dumping

1. Select Screen Dump for the File menu. Select Printer... on the submenu of the File menu.

2. The Print dialog appears. Conduct printing in accordance with the same procedures as those used in (1) Printing an Image.
1.2 Printing with the PG3000, PG3500, PG4000 or PSD400 High-Resolution Printer (option)

1 Activate the image window you want to print (6 parallel lines will be displayed on the window bar in front of the desktop window).

2 Select Print Pictro... from the File menu. The Print by PICTRO dialog shown below will be displayed.
1:1 Image  When Scale is 100%, output will be at the actual size. Use Options... for fine adjustments. See page E-6 for printing at actual size of an image captured from an external device (images read by other than the IP Reader or Fluorescent Reader).

1:1 Pixel  Image will be output with its pixels made to correspond to PICTRO dpi.

4 Select Positioning or Trimming. (The initial setting is Positioning.)

Positioning  Designate the layout for the paper used in printing.
When the centering box is clicked, the image will be printed at the same size in the center of the paper. However, by dragging the entire image, you can freely change where it will be printed.

Trimming  Determine the pixel size for output, making your selection from the 1:1 Pixel pulldown menu.
You can designate the region of the image to print. (Initially, the window will be displayed.)
After designating the region, click Print... and printing will be done.
Note: To position an image that has been trimmed, designate the region to be printed and then switch to Positioning.

**Direction:**
Select whether to position the image horizontally or vertically in relation to paper.

**Paper:**
Select paper size for printing.

**Note:** Paper sizes
Sizes of the paper that can be used differ depending on the connected printer.

1. When PG3000, PG3500 is connected:
   - A4/B5 or Letter/Half L (for overseas)
   * When Letter/Half L is used, selecting Print Pictro... in the File menu while holding the option key down, selection in Paper Size will be changed.

2. When PG4000 or PSD400 is connected:
   - Paper sizes that the software can handle are limited according to PG4000 specifications.
   Available paper size is automatically changed in accordance with the paper width specified for PG4000.
   - When paper width is 297mm: A3/A4
   - When paper width is 127mm: 2L (5R for overseas)
   - When paper width is 297mm (for overseas): D-Letter/Letter
5 It is possible to print out with the image the objects made with each mode. Select the mode that has object in Information: options. Selected mode will be checked ☑.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Annotation</td>
<td>For printing out with the image the objects made in Annotation mode.</td>
</tr>
<tr>
<td>Quant</td>
<td>For printing out with the image the objects made in Quant mode.</td>
</tr>
<tr>
<td>Profile</td>
<td>For printing out with the image the objects made in Profile mode.</td>
</tr>
<tr>
<td>Distance</td>
<td>For printing out with the image the objects made in Distance mode.</td>
</tr>
</tbody>
</table>

* A multiple number of modes can be selected.

6 When Options... is clicked, the following Pictro Print Options dialog will appear. After setting the necessary items, click OK.

- **Comment**: For putting a comment outside of the image region. Input the comment in the Comment box.
  - None: When no comment is needed.
  - Top: Puts the input comment at the top.
  - Bottom: Puts the input comment at the bottom.
- **CLUT**: Puts the Color Look Up Table at the edge of the image area.
  - None: When no CLUT is needed.
  - Top: Puts the CLUT at the top end.
  - Bottom: Puts the CLUT at the bottom end.
- **Back**: Specifies background color for the comment and CLUT.
  - None: When no background color is needed.
  - White: Specifies white for background color.
- **Adjust Width/Height**: Allow actual output size to be finely adjusted in increments of 0.1%.

7 Click OK in the Print by PICTRO dialog and then print.
1.2 Printing with the PG3000, PG3500, PG4000 or PSD400 High-Resolution Printer (option)

(2) Screen Dumping

1. Select Screen Dump for the File menu. Select Printer... on the submenu of the File menu.

2. The Print dialog appears. Conduct printing in accordance with the same procedures as those used in (1) Printing an Image.
2. Printing Quantified Results

2.1 Using Quant Result for Printing Quantified Results

1. Activate the Quant Result window on the desktop.

<table>
<thead>
<tr>
<th>NO</th>
<th>Index</th>
<th>%</th>
<th>ALL</th>
<th>Area [mum²]</th>
<th>ALL [%]</th>
<th>% of Gap</th>
<th>ALL [%m²]</th>
<th>(L-E) [%m²]</th>
<th>Info</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td>1539000.00</td>
<td>1398.00</td>
<td>10238000.00</td>
<td>22.00</td>
<td>13515.00</td>
<td>13515.00</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td>1534800.00</td>
<td>815.36</td>
<td>12248000.00</td>
<td>15.90</td>
<td>16590.00</td>
<td>16590.00</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td>3320000.00</td>
<td>1688.36</td>
<td>39230000.00</td>
<td>46.97</td>
<td>23210.00</td>
<td>23210.00</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td>1253000.00</td>
<td>766.39</td>
<td>12530000.00</td>
<td>15.02</td>
<td>16590.00</td>
<td>16590.00</td>
<td></td>
</tr>
</tbody>
</table>

2. Select Print... from the File menu.

3. The following dialog will appear. Select which of the two printing methods you want by clicking.

   Select Printing Way
   
   Normal
   Group
   Cancel

   Normal  Prints out all the numbers for quantification results altogether.
   Group    Prints out by group, using separate pieces of paper for each.

4. When the printer driver dialog appears, print.
2.2 Printing Quantified Results using Profile Result

1. Activate the Profile Result window on the desktop.

![Profile Result Table]

<table>
<thead>
<tr>
<th>No.</th>
<th>L1</th>
<th>Area Name</th>
<th>PSL</th>
<th>PSL-D5</th>
<th>Ratio</th>
<th>% of L1</th>
<th>Dist(mm)</th>
<th>RP</th>
<th>Inf</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>4</td>
<td></td>
<td>91.71</td>
<td>91.71</td>
<td>---</td>
<td>30.63</td>
<td>10.00</td>
<td>0.10</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>4</td>
<td></td>
<td>57.59</td>
<td>57.59</td>
<td>---</td>
<td>10.27</td>
<td>20.60</td>
<td>0.90</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td></td>
<td>119.98</td>
<td>119.98</td>
<td>---</td>
<td>40.12</td>
<td>52.21</td>
<td>0.47</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>4</td>
<td></td>
<td>29.88</td>
<td>29.88</td>
<td>---</td>
<td>9.93</td>
<td>54.61</td>
<td>0.59</td>
<td></td>
</tr>
</tbody>
</table>

2. Select Print... from the File menu.

![File Menu]

3. When the printer driver dialog appears, set the necessary items and click the Print button.

2.3 Printing Result Table using Distance Result

Print the result table according to the same procedures as those used in 2.2. Profile Result above.
3. Printing Profile Graph

1. Activate the target profile graph.

2. Select Print... from the File menu.

3. When the printer driver dialog appears, set the necessary items and click the Print button.
Part F

Applying Data to Other Applications
1. Registering Other Applications

You can register other applications that you want to use in the Applications menu. By doing so, you can take arbitrarily specified data from image or quantification results and by clicking the application once, simultaneously start it up and save what has been specified as a file.

1. Select Entry... from the Applications menu.

![Applications menu]

2. When the Entry Application dialog appears, click Entry... .

![Entry Application dialog]

3. In the following dialog, click Ok for the application that you want to register to select it.
   [In this example, Graphic Soft Canvas™ 3.5.1 (Deneba Co., Ltd.) has been selected.]
4 Make a selection for Save File Type in the Entry Application dialog. Select Fuji when the application is image processing software. Select PICT when it is word processing or table-calculating software.

5 When OK is selected, registration will be complete.
2. Launch Function

Select the data you want to use. For example, activate the image window in Image Gauge. (By doing so, all of the current image data will be selected.)

1. Select Canvas from the Applications menu.

2. The following Launch Application dialog will be displayed. By clicking, select either Save & Launch... or Launch Only... .

   - After Quit
   - Save & Launch...
   - Cancel
   - Launch Only...

- After Quit: When memory is not sufficient to allow Image Gauge and the appropriate software to be opened at the same time, turn this option ON to quit Image Gauge and then start up the other software.
- Save & Launch...: After saving data in a file, starts up the appropriate software and opens the file.
- Launch Only...: Without saving data in a file, starts up the appropriate software and opens the file.
3 Here is the image data sent to Canvas. In the following example, the left is the image with Image Gauge and the right the image with Canvas.
For Microsoft's Excel and Adobe's Photoshop the same procedure can be used for Launch.

### Excel

<table>
<thead>
<tr>
<th>No.</th>
<th>PSL</th>
<th>Area (mm²)</th>
<th>PSL-BG</th>
<th>% of Grp</th>
<th>PSL/mm²</th>
<th>(P-B)/mm²</th>
<th>Info</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1057.00</td>
<td>26.64</td>
<td>1051.00</td>
<td>7.94</td>
<td>39.66</td>
<td>39.45</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>721.00</td>
<td>18.60</td>
<td>717.00</td>
<td>5.42</td>
<td>38.76</td>
<td>38.55</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>699.00</td>
<td>22.44</td>
<td>694.20</td>
<td>5.25</td>
<td>31.15</td>
<td>30.93</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>1787.00</td>
<td>25.92</td>
<td>1782.00</td>
<td>13.44</td>
<td>68.95</td>
<td>68.74</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>364.20</td>
<td>16.80</td>
<td>360.60</td>
<td>2.74</td>
<td>21.68</td>
<td>21.47</td>
<td></td>
</tr>
</tbody>
</table>

### Photoshop

![Image of Photoshop interface with annotations and tools]
3. Copying and Pasting

When Copy and Paste are used with the data applications of other functions, it is possible to use text information from quantification results or PICT images, etc.

1. Specify the desired information for the image, quantification results, etc. (In this example, the measurement No. from Quant Result will be used.)

<table>
<thead>
<tr>
<th>No.</th>
<th>PSL</th>
<th>Area (mm²)</th>
<th>PSL-BG</th>
<th>% of Grp</th>
<th>PSL/mm²</th>
<th>(P-B)/mm²</th>
<th>Info</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>1282.00</td>
<td>23.76</td>
<td>1277.00</td>
<td>14.78</td>
<td>53.96</td>
<td>53.75</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>879.50</td>
<td>22.44</td>
<td>674.70</td>
<td>7.83</td>
<td>30.28</td>
<td>30.07</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>879.60</td>
<td>25.64</td>
<td>873.90</td>
<td>10.14</td>
<td>30.02</td>
<td>32.81</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>607.70</td>
<td>18.00</td>
<td>603.70</td>
<td>7.76</td>
<td>35.90</td>
<td>35.68</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>402.00</td>
<td>22.44</td>
<td>397.20</td>
<td>4.63</td>
<td>17.92</td>
<td>17.70</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>1320.00</td>
<td>35.20</td>
<td>1312.00</td>
<td>15.21</td>
<td>37.49</td>
<td>37.28</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>148.70</td>
<td>15.80</td>
<td>145.10</td>
<td>1.71</td>
<td>8.85</td>
<td>8.64</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>1704.00</td>
<td>23.76</td>
<td>1698.00</td>
<td>19.64</td>
<td>71.70</td>
<td>71.49</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>1580.00</td>
<td>22.44</td>
<td>1575.00</td>
<td>18.21</td>
<td>70.39</td>
<td>70.18</td>
<td></td>
</tr>
</tbody>
</table>

2. Select Copy from the Edit menu.

3. Activate the spreadsheet software, Excel (Microsoft Co.) and paste in a new spreadsheet.

Hereafter, this data can be handled as Excel data.
Even if the file has been made with another application (or system), if it is in RAW format (data-only format), PICT format or TIFF format (provided that it is an 8bit/16bit-grey TIFF, palette color TIFF or RGB color TIFF), it will be possible to open that file in Image Gauge. Doing so will make it possible to create a calibration curve and conduct quantification.

1. Select Custom... (or PICT... or TIFF...) on the Import File submenu from the File menu.
Custom

1-1 If the file is in RAW format (data-only format), select Custom...
The following Import File dialog will be displayed. Input the values for depth, offset, and width and height, click OK, and open the file.

1-2 If the file is in PICT format, select PICT... and open the file.

TIFF

1-3 If the file is in TIFF format, select TIFF... and open the file.

* The following TIFF formats can be read: 8bit/16bit-grey TIFF, palette color TIFF or RGB color TIFF

2 Specify the name for the file in the following dialog.
5. Saving the File in Other Format

It is possible to convert Profile and Result table into the PICT or TEXT file.

1. Select PICT... or TEXT... from Export File of the File menu, while the window is being activated.

2. Input the file name and specify the destination for saving. The file will be saved with the following icons.
It is possible to convert the image into PICT, TIFF, RAW on Fuji Film's standard format.

1. Select PICT..., TIFF..., RAW... or Fuji Exchange Format... from Export File of the File menu, while the window is being activated.

2. Input the file name and specify the destination for saving. The file will be saved with the following icons.

- **For PICT:**
  - ![PICT](image)
  - `Southern.pict`

- **For TIFF:**
  - ![TIFF](image)
  - `Southern.TIFF`

- **For RAW:**
  - ![RAW](image)
  - `Southern.img`

- **For Fuji Exchange Format:**
  - ![INFO](image)
  - `Southern.img` and `Southern.inf`

*The "RAW format" is the raster file.*

*Fuji Exchange Format...
If you want to analyze data saved on the Macintosh on a different platform (Windows or Solaris) using the Fujifilm (Science Systems) software (Science Lab, BASstation), convert the data into Fuji Film's standard format.

The Fuji Film's standard format consists of `XXX.img` of the raster file and `XXX.inf` of the information file. The Fuji Film (Science Systems) software opens the raster file while viewing the information file and views system parameters contained in the information file while performing quantification.*
5. Storing the File in Another Format

* When a PICT file is selected, following dialog will be displayed.

![Image Resolution to save]

Original... : Converts to 8bit-PICT file without thinning out the pixel from original image. (If it is the 2byte-data, decreases gradation to the upper/lower limit value on Range Scope.)

Window... : Converts conditions actually displayed on the window, such as color, annotation, ROI, etc., to an 8bit-PICT file according to the pixel size on the monitor. (Only image data will be converted to the file and other information will not be stored.)

* When a TIFF file is selected, following dialog will be displayed.

![Image Resolution to save]

Window... : Converts conditions actually displayed on the window, such as color, annotation, ROI, etc., to TIFF file (or palette color TIFF) according to the pixel size on the monitor.

Original(8bit)... : Converts to 8bit-grey TIFF file without thinning out the pixel size from original image. If it is the 2byte-data, decreases gradation to the upper/lower limit-value on Range Scope.

Original(16bit)... : Converts 2byte-data to 16bit-grey TIFF file without thinning out the pixel size from the original image. For 8bit data, this function cannot be selected.
Part

G

Convenient Menu Functions to Learn
1. File Menu

Revert
This function rereads the original file for the currently open image and opens it. However, this cannot be used if there is no image file.

Preference - Display
This file is for setting the image display conditions.

Paint Saturated Data to Red: Displays over-saturated pixels in red in all modes.
Always Show All Entry Area: Displays the ROI, lane or characters specified in each mode also in other modes.
Show Annotation Information: Displays arrows and characters in Annotation mode.
Show Quant Area Number: Displays the number of quantification area specified in Quant mode.
Show Profile Area Number: Displays the line or lane number specified in Profile mode.
Show Molecular Weight Contour Lines: Displays the contour lines in measurements of molecular weight in Profile mode.
Show Distance Item Number: Displays the line number specified in Distance mode.
Set Positive Gray to All Images: Displays the image in gray when opening it the first.
Set Display Type to All Images: Selects gradation curve type when opening the image the first. Use the pull-down menu.

Default: Uses the gradation curve referred to in User Tips on page B-26.
Linear: Uses the linear tone curve.
Sigmoid: Uses the S tone curve.
Exponential: Uses the exponential tone curve.

Preference - Distance
This function is used to set the unit of distance.
2. Image Menu

Standard Mag
Restores images, Profiles, etc., enlarged with the Magnifying Glass to their initial condition.

3. Analysis Menu

Sort
Sorts the measurement Nos. on the Result window in numerical order. (When group settings are made, this will be done for each group.)

---

<table>
<thead>
<tr>
<th>NO</th>
<th>Index</th>
<th>S</th>
<th>PSL</th>
<th>Area (p=2)</th>
<th>PSDLG</th>
<th>% of Gap</th>
<th>PSL/Dp2</th>
<th>(P-B)/Dp2</th>
<th>Info</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>-</td>
<td>1</td>
<td>1707.80</td>
<td>648</td>
<td>1707.00</td>
<td>23.02</td>
<td>2.75</td>
<td>2.76</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>-</td>
<td>1</td>
<td>679.60</td>
<td>666</td>
<td>679.60</td>
<td>11.79</td>
<td>1.72</td>
<td>1.55</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>-</td>
<td>1</td>
<td>721.80</td>
<td>485</td>
<td>721.00</td>
<td>9.85</td>
<td>1.58</td>
<td>1.58</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>-</td>
<td>1</td>
<td>679.50</td>
<td>561</td>
<td>679.50</td>
<td>9.10</td>
<td>1.21</td>
<td>1.21</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>-</td>
<td>1</td>
<td>364.20</td>
<td>420</td>
<td>364.20</td>
<td>4.00</td>
<td>0.77</td>
<td>0.77</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>-</td>
<td>1</td>
<td>1657.80</td>
<td>666</td>
<td>1657.00</td>
<td>14.15</td>
<td>1.59</td>
<td>1.59</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>-</td>
<td>1</td>
<td>1282.80</td>
<td>561</td>
<td>1282.00</td>
<td>17.15</td>
<td>2.15</td>
<td>2.15</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>1</td>
<td>699.00</td>
<td>561</td>
<td>699.00</td>
<td>9.35</td>
<td>1.23</td>
<td>1.23</td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
</tbody>
</table>

---

<table>
<thead>
<tr>
<th>NO</th>
<th>Index</th>
<th>S</th>
<th>PSL</th>
<th>Area (p=2)</th>
<th>PSDLG</th>
<th>% of Gap</th>
<th>PSL/Dp2</th>
<th>(P-B)/Dp2</th>
<th>Info</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>-</td>
<td>1</td>
<td>1657.80</td>
<td>666</td>
<td>1657.00</td>
<td>14.15</td>
<td>1.59</td>
<td>1.59</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>-</td>
<td>1</td>
<td>721.80</td>
<td>485</td>
<td>721.00</td>
<td>9.85</td>
<td>1.58</td>
<td>1.58</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>1</td>
<td>699.00</td>
<td>561</td>
<td>699.00</td>
<td>9.35</td>
<td>1.23</td>
<td>1.23</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>1</td>
<td>1707.80</td>
<td>648</td>
<td>1707.00</td>
<td>23.02</td>
<td>2.75</td>
<td>2.75</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>-</td>
<td>1</td>
<td>364.20</td>
<td>420</td>
<td>364.20</td>
<td>4.00</td>
<td>0.77</td>
<td>0.77</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>-</td>
<td>1</td>
<td>1282.80</td>
<td>561</td>
<td>1282.00</td>
<td>17.15</td>
<td>2.15</td>
<td>2.15</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>-</td>
<td>1</td>
<td>679.50</td>
<td>561</td>
<td>679.50</td>
<td>9.10</td>
<td>1.21</td>
<td>1.21</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>-</td>
<td>1</td>
<td>879.80</td>
<td>666</td>
<td>879.60</td>
<td>11.78</td>
<td>1.32</td>
<td>1.32</td>
<td></td>
</tr>
</tbody>
</table>
4. Image Menu

Renumber

Assigns new measurement Nos. to compensate for missing Nos.

<table>
<thead>
<tr>
<th>No.</th>
<th>Index</th>
<th>G</th>
<th>FSL</th>
<th>Area (p&lt;2)</th>
<th>FSL/Bg</th>
<th>% of Grp</th>
<th>FSL/p&lt;2</th>
<th>(F-E)/p&lt;2</th>
<th>Info</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>-</td>
<td>1057.00</td>
<td>664</td>
<td>1057.00</td>
<td>21.21</td>
<td>1.35</td>
<td>1.59</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>-</td>
<td>721.00</td>
<td>455</td>
<td>721.00</td>
<td>14.47</td>
<td>1.55</td>
<td>1.55</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>364.20</td>
<td>420</td>
<td>364.20</td>
<td>7.31</td>
<td>0.37</td>
<td>0.87</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>1262.00</td>
<td>594</td>
<td>1262.00</td>
<td>25.72</td>
<td>2.16</td>
<td>2.16</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>-</td>
<td>579.50</td>
<td>551</td>
<td>579.50</td>
<td>10.54</td>
<td>1.21</td>
<td>1.21</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>-</td>
<td>370.50</td>
<td>664</td>
<td>370.50</td>
<td>17.55</td>
<td>1.32</td>
<td>1.32</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

4. Image Menu

Change Color

Specify the order of colors on the pseudo-color display.
Index
Index

A

About This Quant ............................................. D-13
Adjuster ......................................................... B-18
Analysis Modes ............................................... C-2
Angle Tool ....................................................... C-79
Annotation Mode ............................................. C-10
Applications .................................................... F-2
Area Name ...................................................... D-2
Area of the Measured Region ............................. D-2
Arrow Tool ...................................................... C-15
Auto Background ............................................. D-40
Auto Lane & Band ............................................ C-63
Automatic Lane / Band Tool ............................... C-62

B

Background ..................................................... D-7
Background Tool .............................................. D-30
Brightness/Contrast .......................................... B-16

C

Calibration ....................................................... D-15
--- Curve ......................................................... D-18
Centering Box ................................................. E-3, E-11
Change Color .................................................. G-4
Clear BG Line .................................................. D-32
Clip Image ....................................................... C-11
Close Box ....................................................... B-15
cnt ................................................................. C-6
Color Type ..................................................... B-16
Comment Input Box ......................................... C-21
Convert Function ............................................. D-58
Copy & Paste .................................................. D-60
Copy RF Ratio .................................................. D-50
Copy BG Line .................................................. D-28
Curve ............................................................ B-23
--- Adjuster ..................................................... B-23
--- Box ........................................................... D-18

D

Data Info .......................................................... D-13
Data Information .............................................. D-2
Density .......................................................... D-17
Density Calibration .......................................... D-17
Density Picker Tool ......................................... C-5, D-38
Display Mode .................................................. D-23
Displaying Profiles ......................................... C-74
Distance
--- Calibration ............................................... E-7
--- Mode ......................................................... C-75
--- Result ....................................................... C-76
--- Tool ......................................................... C-75
--- Unit .......................................................... G-2
Duplicate ........................................................ C-50

E

Enter Rect Coordinate ...................................... C-12
Entry Application ............................................. F-2
Exponential ..................................................... B-21
Export File ..................................................... F-10

F

File
--- Info ............................................................ C-21
--- Information ................................................ C-21
Free-Division Matrix Tool .................................. C-36
Free Edit Tool ................................................ C-47
Free Hand Tool ............................................... C-24

G

Global ........................................................... D-9
Graph Slider Tool ........................................... D-23
Group ............................................................ D-2, D-4
Grow Handle .................................................. C-23

H

Hand Tool ....................................................... C-9, D-26
Handle ........................................................... D-31
Horizontal GB Tool .......................................... D-27
--- Magnifying Glass Tool ............................. D-24

I

Image
--- Display ...................................................... G-2
--- Reader ..................................................... B-8
--- Resize% .................................................... C-11, C-19
--- Selector Tool .......................................... C-10
Import
--- File ........................................................... F-8
--- Function ................................................... B-26
Index ............................................................. D-2
Info Stamp Tool ............................................. C-16
Information Stamp ......................................... C-16
Install .......................................................... A-4
Integral Tool .................................................. D-34
Interval Tool .................................................. C-77
Index

T
Text & Font ................................................................. C-13
Text Tool ................................................................. C-13
32 color ................................................................. B-16
Titer Plate Tool .................................................. C-43
Title Bar ................................................................. B-15
Tone Curve ......................................................... B-23
Tool Box ................................................................. B-15
--- Scroll Arrow ................................................... B-15
Trace Resolution .................................................. C-25, C-46
Triangular ............................................................. B-25
Trim Again ............................................................ B-10
Trimming ......................................................... B-10, E-3, E-11
--- Box ................................................................. B-10

U
Ungroup ................................................................. D-5
Unit ................................................................. B-15

V
Value
--- per 1mm^2 .......................................................... D-2
--- per 1mm^2 Background Subtracted ................... D-2
--- per 1mm^2 with Background Subtraction .......... D-2
Vertical Magnifying Glass Tool ......................... D-25
View ................................................................. B-17
View Scope .......................................................... B-27

Z
Zoom Box ................................................................. B-15
Science Lab 2001
L Process  Ver.2.0
Operation Manual
Thank you for purchasing FUJIFILM Science Lab L Process Ver. 2.0 Before using this software, please be aware of the following important items.

Regarding the use of Science Lab 2001 L Process software:
When you first started using this software, you agreed to the usage conditions specified below, and Fuji Photo Film Co., Ltd. granted you a license to use the Science Lab 2001 L Process software.
The ownership rights to the software belong to Fuji Photo Film Co., Ltd. Part of the ownership rights to this software belongs to ALTURA SOFTWARE, INC. In keeping, this software is not something that is sold to you but something that Fuji Photo Film Co., Ltd. grants you a license to use. The recording media is yours, but the ownership rights to the software remain with Fuji Photo Film Co., Ltd.

LICENSE TERMS
1) You are granted the use of Science Lab 2001 L Process for a single CPU or a single unit within multiple CPUs. Hence, in a computer network environment, a separate Science Lab 2001 L Process license will be required for each unit that will be using the software.
2) You are allowed to copy Science Lab 2001 L Process onto different media for backup and program execution purposes.

USAGE LIMITATION
1) No copying, modification or transfer of Science Lab 2001 L Process other than specified by the terms of the usage license is allowed.
2) No reverse compiling or reverse assembling of Science Lab 2001 L Process done for the purpose of turning Science Lab 2001 L Process into a readable format is allowed.
3) No lending or distribution of Science Lab 2001 L Process or a part thereof for profit is allowed.
4) No derivative copyrighted product can be produced from Science Lab 2001 L Process, or modifications of it, or in conjunction with other software.

NOTES
1) Reproduction of parts or all of the contents of this manual without permission is prohibited.
2) The contents of this manual are subject to change without notice.
3) This manual has been prepared with utmost care. However, if you have any questions or find errors, omissions, etc., please contact us.
4) We will not be liable for any effects incurred from the use of this device.

Copyright Reserved
<Reprint and/or reproduction of parts or whole of this manual is prohibited.>
Copyright © 1998-1999 by Fuji Photo Film Co., Ltd.

Apple logo is a registered trademark of Apple Computer, Inc. Canvas™ is a registered trademark of Deneba Co., Ltd. Excel is a registered trademark of Microsoft Co., Ltd. Macintosh, Quick Time, and Geneva are registered trademarks of Apple Computer, Inc. Adobe Photoshop is a registered trademark of Adobe Systems Co., Ltd. in the U.S. All other company names and product names mentioned here in are the trademarks or registered trademarks of their respective owners.
"Portions of this product are copyright ©1991-1997 Altura Software Inc. All rights reserved."

"COMPANY’S LICENSOR (S) MAKES NO WARRANTIES, EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, REGARDING THE SOFTWARE. COMPANY’S LICENSOR (S) DOES NOT WARRANT, GUARANTY, OR MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF THE USE OF THE SOFTWARE IN TERMS OF ITS CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE SOFTWARE IS ASSUMED BY YOU. THE EXCLUSION OF THE IMPLIED WARRANTIES IS NOT PERMITTED BY SOME STATES. THE ABOVE EXCLUSION MAY NOT APPLY TO YOU."

"IN NO EVENT WILL COMPANY’S LICENSOR (S), AND THEIR DIRECTORS, OFFICERS, EMPLOYEES, OR AGENTS (COLLECTIVELY "COMPANY’S LICENSOR") BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, INCIDENTAL, OR INDIRECT DAMAGES (INCLUDING DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, AND THE LIKE) ARISING OUT OF THE USE OF, OR INABILITY TO USE, THE SOFTWARE EVEN IF COMPANY’S LICENSOR HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU."
This equipment cannot be taken to or used in a country or area where power supply specifications differ from those in the country or area where it was originally installed.

**JAPAN**

This device is in compliance with the VCCI standards established by the conference on self-imposed control of noise interference caused by information devices for the purpose of preventing interference in commercial and industrial areas caused by Class 1 information devices (information devices to be used in commercial and industrial areas). If this device is used in residential areas adjacent to them, it may cause radio disturbance. This device must be handled correctly in accordance with this operation manual.

**United States of America**

This equipment generates, uses, and can radiate radio frequency energy and if not installed and used in accordance with the instructions manual, may cause interference to radio communications. It has been tested and found to comply with the limits for a Class A computing device pursuant to Subpart J of part 15 of FCC Rules, which are designed to provide reasonable protection against such interference when operated in a commercial environment. Operation of this equipment in a residential area is likely to cause interference in which case the user at his own expense will be required to take whatever measures may be required to correct the interference.

**Canada**

This digital apparatus does not exceed the Class A limits for radio noise emission from digital apparatus as set out in the radio interference regulations of the Canadian Department of Communications.

“Le présent appareil numérique n’émet pas de bruits radioélectriques cépassant les limites applicable aux appareils numériques de la class A prescrites dans le Règlement sur le brouillage radioélectrique édicté par le ministère des Communications du Canada.”
Contents

1. L Process Ver.2.0 ............................................................................................................... 1
2. System Configuration ........................................................................................................ 2
3. Overview .......................................................................................................................... 1
4. Operation .......................................................................................................................... 2
   4.1 Starting Up .................................................................................................................. 2
   4.2 Opening an Image ....................................................................................................... 2
   4.3 Window When Image is Opened .................................................................................. 6
   4.4 Changing the Display ............................................................................................... 7
      4.4.1 Changing the Display Color ................................................................................ 7
      4.4.2 Adjusting Gradation ......................................................................................... 7
      4.4.3 Magnifying and Reducing the Image Display .................................................... 13
      4.4.4 Enhancing Contrast ......................................................................................... 15
   4.5 Clipping Out a Region ............................................................................................... 17
   4.6 Measuring the Angle .................................................................................................. 19
4.6 Processing ..................................................................................................................... 21
   4.6.1 Applying FFT ...................................................................................................... 21
   4.6.2 Applying Rotational Filter .................................................................................. 24
   4.6.3 Applying Inverse-FFT ....................................................................................... 25
      (a) Circle Mask tool ................................................................................................. 25
      (b) Donut Mask tool ............................................................................................... 26
      (c) Twin Mask tool ................................................................................................. 27
      (d) Lane Mask tool ................................................................................................. 28
      (e) Freehand Mask tool .......................................................................................... 29
      (f) Array Mask tool ................................................................................................. 30
   4.6.4 Saving the FFT Image .......................................................................................... 31
   4.6.5 Applying Filter ..................................................................................................... 32
      (a) Applying averaging ............................................................................................... 34
      (b) Applying Median ............................................................................................... 36
      (c) Applying Gradient ............................................................................................. 36
      (d) Applying Roberts ............................................................................................... 38
      (e) Applying Sobel ................................................................................................... 39
      (f) Applying Laplacian ............................................................................................. 40
      (g) Applying Prewitt ............................................................................................... 41
      (h) Applying Marr-Hildreth .................................................................................... 42
      (i) Applying Sharp Filter ....................................................................................... 43
(j) Applying Unsharpmask ................................................................. 44
(k) Applying Custom ................................................................. 45
4.6.6 Inverting the Image Data ................................................................. 46
4.6.7 Filtering the Hot/Cold Spot ................................................................. 47
4.6.8 Rotate Function ................................................................. 49
4.6.9 Flip Function ................................................................. 53
4.6.10 Joint Function ................................................................. 55
4.6.11 Modifying the Image Aspect Ratio ................................................................. 57
4.6.12 Using Arithmetic ................................................................. 59
4.6.13 Manually Aligning the Image Position ................................................................. 62
4.6.14 Semi-automatically Aligning the Image Position ................................................................. 64
   (a) Markspot tool ................................................................. 64
   (b) Markline tool ................................................................. 68
4.6.15 Displaying Calculation Overflow/Underflow During Image Processing ................................................................. 72
4.6.16 Displaying the Composed Fluorescent Image ................................................................. 73
4.6.17 Displaying the Contour Line ................................................................. 75
4.7 Displaying Multiple Images ................................................................. 78
   (a) Cascade ................................................................. 78
   (b) Tile ................................................................. 79
4.8 Saving ................................................................. 80
   (a) Save ................................................................. 80
   (b) Save as ................................................................. 80
   (c) Export ................................................................. 81
4.9 Undoing Processing ................................................................. 83
4.10 Viewing Image Information ................................................................. 84
4.11 Printing ................................................................. 85
   4.11.1 Printing Image on Laser Beam Printer ................................................................. 85
   4.11.2 Easily Printing Images Out on Pictrography 3000, 3500, 4000 or PSD400 ................................................................. 86
4.12 Starting Up Other Software ................................................................. 89
1. L Process Ver.2.0

1. L Process Ver.2.0 (hereinafter referred to as "this software,") is for analyzing and quantifying the image data input from the Image Reader originally introduced to the market by Fuji Photo Film Co., Ltd. and for image analysis and quantification of image data in RAW, PICT and TIFF format.

2. The sample screens throughout this manual match the functions described and the assumed selections and items that appear. In keeping, when reading the manual.

3. For details on image reading through the IP Reader (BAS series and FDL-5000), IP/Fluorescent Reader (FLA-2000 / 2000G, FLA-3000 / 3000G, FLA-5000, FLA-8000) or Chemiluminescent/Fluorescent detecting camera (LAS-1000 / LAS-1000plus / LAS-1000mini), refer to each operation manual.

4. Image files created with versions earlier than this software (MacBAS V2.0 ~ V3.0, Image Gauge V.3.01 ~ V3.4) can be opened, analyzed and subjected to other operations using this software. Image files created with this software, however, cannot be used with previous versions (upwardly compatible).

5. Use of this software has been confirmed for the following combinations of systems connected to the IP Reader. If other combinations are used, the software may become inoperable, depending on the SCSI.

Macintosh: PowerMac G4 733
Blue G3, G4, G3 MT266/ZIP, MT300/ZIP
* This software cannot be used on the 68K machine.

OS: Mac OS 9.21

SCSI card: 2906 (Adaptec)

CRT: 832x624 or more, 256 color or more
(we recommend the 32,000 color or more.)

LBP: LBP 350 (Canon)

Peripheral devices: Pictrography 3000(32MB/48MB), 3500,4000(120MB), PSD400(96MB)

Application memory: Will differ depending on the image file size handled.

<table>
<thead>
<tr>
<th>Reader</th>
<th>Application Memory</th>
</tr>
</thead>
<tbody>
<tr>
<td>BAS-5000</td>
<td>190MB or more</td>
</tr>
<tr>
<td>FLA-3000/3000G</td>
<td>95MB or more</td>
</tr>
<tr>
<td>BAS-2500</td>
<td></td>
</tr>
<tr>
<td>FLA-2000</td>
<td>90MB or more</td>
</tr>
<tr>
<td>FLA-2000G</td>
<td></td>
</tr>
<tr>
<td>BAS-1800II</td>
<td>75MB or more</td>
</tr>
<tr>
<td>BAS-1800</td>
<td>70MB or more</td>
</tr>
<tr>
<td>BAS-1500</td>
<td>36MB or more</td>
</tr>
<tr>
<td>BAS-1000</td>
<td>25MB or more</td>
</tr>
<tr>
<td>FDL-5000</td>
<td>45MB or more</td>
</tr>
<tr>
<td>LAS-1000</td>
<td>25MB or more</td>
</tr>
<tr>
<td>LAS-1000plus</td>
<td></td>
</tr>
<tr>
<td>FLA-5000</td>
<td>582MB or more</td>
</tr>
</tbody>
</table>

(Image file size + 10~20MB)

This manual has been written based on the assumption that the user has experience using the Macintosh and is familiar with its basic operation and displays.
2. System Configuration

<Supporting Peripheral Devices> (underlined units: available for old users)


Image buffer: IB-200

Pictro: Pictrography 3000 (32MB/48MB), Pictrography 3500 , Pictrography 4000 (120MB), PSD-400 (Either one)

LBP: LBP320 Pro (Canon), LBP750 (Canon), LBP350 (Canon), Laser Jet 6L(HP), Laser Jet 4LJ Pro(HP), Laser Writer Select 610(Apple) (Either one)

* 2MB memory should be expanded for the Canon's LBP and HP's LBP.
3. Overview

System configuration, installation method, etc. for L Process Ver.2.0 are the same as for those for Image Gauge Ver. 4.0. See pages A-4 in the Operation Manual for Image Gauge Ver. 4.0.

4. Operation

4.1 Starting Up

Click the L Process icon to open it, shown below.

L Process will start up along with the following opening screen.

4.2 Opening an Image

L Process can handle the following kinds of images.

(1) ***.img of image data read with the FDL5000.
(2) Data transmitted from the Image Reader to the Macintosh.
(3) Image data saved in Image Gauge or MacBAS (Ver.2.0 or later) original format.
(4) Image Gauge/MacBAS data saved in PICT, TIFF, or RAW format.

(5) Image data saved in L Process original format.

(6) Data from the L Process saved in PICT, TIFF, or RAW format.

(7) TIFF format data saved in Image Reader for LAS.

(8) Data from other applications saved in PICT (the majority), TIFF (8bit/16bit-grey, palette color or RGB full-color), or RAW format.

To open an image, select Open or Import from the File menu on the menu bar.

Open
Used when opening (1), (2), (3), (4), (5) and (7), above.

Import
Used when opening (4), (6), and (8), above.

When Import is selected, a window like the following will open.
Specify the file format in the above window.

File Format: PICT
TIFF
RAW

When "RAW" is first selected as the file format, the following window will open. Specify the width and height in terms of pixels, the depth (bit), and header size (byte).

- **Swap Bytes**: Specifies that the top and bottom bytes of the word should be switched when an image is taken up in Intel format.
- **Trade W&H**: Switches the values for Width and Height.
- **Estimate**: Infers Width and Height using the original Depth and Header Size values.
4.3 Window When Image is Opened

When an image is opened, several windows will appear on it, like those shown below.

- **Image window**: Base window for image processing.
- **Tool window**: Window that contains the tools for selecting regions, etc., for magnification, scrolling, and other processing.
- **View window**: Window for confirming the entire image.
- **Gradation adjustment window**: Window for adjusting contrast, brightness, and gradation.
- **Info. window**: Window that displays the position of the tool on the image and the size of the enclosed ROI.
- **Assist window**: Window for fine adjustment of the position and size of the enclosed ROI.
4.4 Changing the Display

4.4.1 Changing the Display Color

Select Color Type from the Image menu and then select the desired monitor display command from the submenu that appears.

- Negative Gray: Displays in negative black and white (low-density regions are white; high-density regions are black).
- Positive Gray: Displays in positive black and white (low-density regions are black; high-density regions are white).
- 16 Color: Displays in 16 pseudo-colors.
- 32 Color: Displays in 32 pseudo-colors. (Brightness/Contrast is used to specify the colors for low- and high-density regions.)
- Red, Green, Blue: Displays fluorescent colors in 32 gradations.

4.4.2 Adjusting Gradation

1. Select Scale Type from the Image menu and then select the desired monitor display command from the submenu that appears.

- Linear: Adjusts contrast with a linear curve.
- Sigmoid: Adjusts gradation with an S tone curve.
- Exponential: Adjusts gradation with an exponential curve.
- Triangular: Adjusts contrast with an serriform cyclic tone curve.
- Rectangular: Adjusts contrast with a rectangular waveform cyclic tone curve.
- Free Hand: Adjusts contrast with a free-hand tone curve.
- Equalization: Adjusts contrast with the tone curve automatically created by the software in accordance with histogram frequency.
2 Linear

Place the cursor inside the gradation bar in the above window and drag it with the (↑, ↓, ←, →) adjusters.

Or, drag the brightness (B) and contrast (C) dials below the gradation bar.

Set values for each will be indicated in real-time. Brightness and contrast can be adjusted even if the adjusted bar inside the histogram is dragged.
3 Sigmoid

Place the cursor inside the gradation bar and drag it with the adjusters (as with Linear) or drag the Sigmoid dial below the gradation bar.

Set values will be indicated in real-time on the right side.

Brightness and contrast can be adjusted even if the adjuster bar inside the histogram is dragged.

With Sigmoid, not only can adjustment be done with the left-right adjuster bar but also with the up-and-down adjuster bar.
4 Exponential

By dragging the curve (C) dial, you can change curvature of the exponential curve.

The value on the right of the curve (C) dial shows curvatures parameters, which will change as the dial is dragged.

Place the cursor inside the gradation bar in the above window and drag it with the adjusters.

You can slide the exponential curve position without changing curvature of the exponential curve whether by placing the cursor in the gradation bar on the window above to drag adjusters or by dragging the upper limit bar appearing on the histogram.
5  Triangular, Rectangular

Drag the phase (P) and frequency (F) dials.

Set values for each will be indicated in real-time.

6  Free Hand

Drag the to create the tone curve.
7 Equalization
As shown in the following figure, the tone curve will be automatically drawn by the software.

User Tips
Image data and default display
Display formats when the image Window was opened and when the Trimming dialog was opened will depend on the image data types.

- BAS series (BAS1000/1500/2000/2500/3000/5000) .......... (Exponential + Negative) display
- FLA series (FLA2000/FLA2000G/FLA3000/FLA3000G) .... (Exponential + Negative) display
- FDL5000 .............................................................................. (Linear + Positive) display
- LAS series (LAS1000/1000C/1000plus) ......................... (Linear + Negative) display
- Import files (Custom, TIFF, PICT) ....................................... (Linear + Positive) display
4.4.3 Magnifying and Reducing the Image Display

The image display can be magnified and reduced using the following 2 methods.

(a) Select Mag. Level from the Image menu and then select the desired magnification level from the submenu that appears.

```
Image
  Color Type
  Scale Type
  Rangescope...

Mag. Level
  1:16
  1:8
  1:4
  1:2
  √1:1
  2:1
  4:1
  8:1
  16:1

Clip Image
```

The numbers given are ratios of the number of pixels on the monitor to the number of pixels of the original image. For example, for level 1:2 (monitor pixels: original image pixels), from 4 pixels of the original image, 1 pixel of the specific position is extracted and the image thinned out (reduced) by making it equal 1 pixel on the monitor.

(b) Selecting the Magnifying Glass tool (🔍) from the tool window and clicking it in the image window to perform magnification and reduction.

Magnifying Glass tool

Select the Magnifying Glass tool (🔍). Bring it inside the image window and it will change to (🔍) for magnification. Press the shift key and it will change to (🔍) for reduction.
About the image window when the magnification level has been raised:

When the magnification level is raised, the entire image region will not be able to fit within the image window. At this time, green and red regions will appear as something like the following in the view window shown below.

Green region: Indicates the region that can be displayed in the image window.
Red region: Indicates the region that is currently displayed in the image window.

Bring the cursor on the red frame, it will change to a \( \text{移动} \). You can move the red frame by dragging. The image in the image window will be scrolled in realtime.

Bring the cursor on the green frame and the option key is pressed, it will change to a \( \text{移动} \). You can move the green frame by dragging. When the green region is moved, the image in the image window will not be scrolled in realtime. Also, it will take more time than moving a red region.
4.4.4 Enhancing Contrast

1. Select Rangescope... from the Image menu.

Rangescope is a function for enhancing the contrast of 14-bit and other high-quantum image files by selecting the contrast portion you want to display.

When the contrast level of the targeted image is concentrated in a narrow range and Rangescope function is used on that narrow range to compress it, a sharper image can be obtained.

(Contrast can be adjusted by using the 8-bit gray scale on the compressed range. When using Rangescope function in color mode, 16 or 32 colors will be available.)

Rangescope function just changes the monitor display and not effects to the quantified values.

Rangescope function is not effective for images of 8 bits or under.

2. The following window will appear.

Overview box: Box that displays the entire image.
Scopeview box: Box that displays the image within the vicinity of the Viewscope frame inside the Overview box.
Rangescope box: Box that displays the intensity distribution of the image region from either the Overview box or the Scopeview box, depending on which has been selected.
3 Click inside the and select Overview or Scopeview. The selected one will change to .

4 To move the Viewscope frame, place the cursor inside the Overview box, where it will change to . Click the desired place and the Viewscope frame will be moved to it.

5 There are two methods for compressing the range
   (5-1) Value-input-based compression
   (5-2) Compression by dragging the adjuster

   (5-1) Click in the Range Scope box
   A dialog as shown below will appear. Directly enter top/bottom values.

   ![Dialog for value input-based compression]

   Click the button. The image will then be re-displayed with newly set values.
   (5-2) Compression by dragging the adjuster
   When the cursor is placed inside the Rangescope box, it will change to an adjuster. Drag the lower limit (red bar on the left side inside the Rangescope box) and the upper limit (blue bar on the right side inside the Rangescope box) to set them.
   (If you leave the cursor between the lower limit and the upper limit, the adjuster will change to . At this point, you can drag the lower and upper limit bars together keeping the same distance.)
   Click to make fine adjustment.

6 After setting the upper and lower limits, click and the image window will change to the adjusted image.
17

4.4.5 Clipping Out a Region

1. Using the Image Selector tool on the tool window, set the region you want to clip out.
(When no region is specified, a copy of the entire image will be made.)

2. Select Clip Image from the Image menu.

3. When no region has been specified to be clipped out, the following confirmation window will appear.
4 The results of Clip Image will be displayed in a new window, as shown below.
(Image processing can be performed on the clipped-out portion. When the clipped-out portion is saved, image volume will correspond to the area that was clipped out.)

After Clip Image has been performed, the cursor will change to \[\text{\textbullet}\]. Click it and the image overlaid on the monitor can be moved up and down.
4.5 Measuring the Angle

1. Select the Angle tool from the Tool window that follows image display. (The cursor will change from to .)

2. In this condition, click the starting point of the angle to be measured on the image. With your finger released from the mouse button, move the mouse to the ending point and then click the mouse again there.

3. Measurement results will be displayed in the Info window, shown below.
Procedure for Modifying
the Unit in which Angle is
Displayed

Degree or Radian are the options available for selecting the unit in which
angles are displayed.

1 Double-click the Angle Tool. (The following Angle Tool Options
dialog will be displayed.)

2 Click the desired unit for displaying angles to select it.

*Note:* It is not possible to draw more than 2 angle measurement lines
at one time on one image. Drawing a new line will result in the
automatic deletion of the line drawn before it.
4.6 Processing

4.6.1 Applying FFT

1. Double-click the Image Selector tool on the tool window. When FFT is applied, the number of pixels in the enclosed area must be expressed as a power of 2.

2. The following Marquee Options window will appear.

   ![Marquee Options Window]

   - **Free (Normal)**: While the Image Selector tool is moved on the window, the number of pixels will be shown as a power of 2. At this time, refer to the number of pixels for width and height specified in the Info. window.
   - **Fixed**: The number of pixels for width (W) and height (H) of the Image Selector tool will be fixed.
   - **$2^n$**: The Image Selector tool moved on the screen will automatically express the number of pixels as $2^n$.

3. In the above window, specify the method for enclosing the area.

   **Free (Normal)**: While the Image Selector tool is moved on the window, the number of pixels will be shown as a power of 2. At this time, refer to the number of pixels for width and height specified in the Info. window.

   ![Info. Window]

   - **Cursor position**
   - **Position of starting point of enclosing frame**
   - **Number of pixels (width)**
   - **Number of pixels (height)**

   Cursor position is viewed in terms of the standard (0, 0 — top left of the screen) and displayed in terms of the number of pixels from the left and the number from the top. The starting point of the enclosing frame is also viewed in terms of the same standard.
4. Select FFT... from the Process menu.

5. The following FFT Option window will appear.

   - Window Function: Rectangular (none)
   - Data type: (Pixel Data) or (Converted Data)
   - Logarithm image

Select the desired window function.

The waveforms for each window function are shown below.
Select the data type.

Data type
- ☐ QL
- ☐ cnt

QL (Quantum Level): Logarithm unit

cnt (count): Linear unit (shows the number of electrons)

However, for an image on which the following intra-image arithmetic is done, the unit will change from cnt to AU.

A ¥ B: multiplication, A/B: division, sqrt(A): deriving the root,
log(A): taking the logarithm.

Data type
- ☐ QL
- ☐ AU

AU: Arbitrary unit

Select whether to handle the image as a logarithm or not after FFT has been applied.

☐ 'Logarithm' image

To handle the image as a logarithm, click ☐ to change it to ☐.
(The original data will remain as is.)

6 When FFT is clicked, FFT will be conducted.
4.6.2 Applying Rotational Filter

The Rotational Filter is used to eliminate FFT image background.

1. After creating an FFT image, select Filter... from the Process menu and then select Rotational... from the submenu that appears.

2. The following Rotational Options window will appear.

```
<table>
<thead>
<tr>
<th>Process</th>
<th>Filter...</th>
</tr>
</thead>
<tbody>
<tr>
<td>FFT...</td>
<td>Averaging...</td>
</tr>
<tr>
<td>Inverse FFT...</td>
<td>Median...</td>
</tr>
<tr>
<td>Filter...</td>
<td>Gradient...</td>
</tr>
<tr>
<td>Invert Pixel...</td>
<td>Roberts...</td>
</tr>
<tr>
<td>Hot/Cold Spot Filter...</td>
<td>Sobel...</td>
</tr>
<tr>
<td>Rotate...</td>
<td>Laplacian...</td>
</tr>
<tr>
<td>Flip...</td>
<td>Prewitt...</td>
</tr>
<tr>
<td>Joint...</td>
<td>Marr-Hildreth...</td>
</tr>
<tr>
<td>Aspect Ratio...</td>
<td>Sharp...</td>
</tr>
<tr>
<td>Arithmetic...</td>
<td>Unsharp Mask...</td>
</tr>
<tr>
<td>Compose...</td>
<td>Custom...</td>
</tr>
<tr>
<td>Contour Plot...</td>
<td>Rotational...</td>
</tr>
</tbody>
</table>
```

Enter the threshold value.

3. Clicking [Filter] will leave pixels that have values larger than the threshold as they are and set values smaller than the threshold to 0.
4.6.3 Applying Inverse-FFT

Inverse-FFT will be applied to an image to which FFT has been applied. After FFT has been applied, all the tools in the tool window will be available for use.

Using the Mask tools in the tool window, set the frequency area for applying Inverse-FFT to an image to which FFT has been applied.

(a) Circle Mask tool

Double-click the Circle Mask tool. The following options window will open.

Set the circle radius in terms of pixels. Even after this has been done, the size of the circle can still be changed as desired on the screen.

Radius: 10 (1...512: pix)

Decide whether the selected region (effective area) will be inside the circle or outside it.

To resize, drag any of the 4 green points.
Double-click the Donut Mask tool. The following options window will open.

Set the radius of the circles inside and outside the donut in terms of pixels. Even after the radii have been set, the size of the circles can still be changed as desired on the screen.

Decide whether the selected region (effective area) will be inside the two circles of the donut or outside them.

To resize, drag any of the 4 green points.
Double-click the Twin Mask tool. The following options window will open.

(c) Twin Mask tool

Set the radius of the circles in terms of pixels. The radius can be modified even after it has been set by using this window. Even after the position of the circles has been set, it can be changed as desired on the screen.

Radius: 10

Decide whether the selected region (effective area) will be inside the twin circles or outside them.

To resize, drag either of the 2 green points.
(d) Lane Mask tool

Double-click the Lane Mask tool. The following options window will open.

```
Lane Mask Options

Width:  [ ] (1 ... 100 : pix)

Effect Area
- Inside
- Outside

[ OK ] [ Cancel ]
```

Set the lane width in terms of the number of pixels. Even after the lane width has been set, it can be modified in this window. Lane length and direction can be changed as desired on screen after settings have been made.

```
Width: 10 (1 ... 100 : pix)
```

Decide whether the selected region (effective area) will be inside the lanes or outside them.

To adjust lane width and direction, drag any of the 4 green points.
(e) Freehand Mask tool

1. Click on the toolbox to select Freehand Mask.

2. On the FFT image, drag from the starting point to the ending point. (If the starting point and ending point are not the same point, the software will automatically connect them.)

3. To set the Inside and Outside options for the Effective Area, double-click Freehand Mask, to call up the following Freehand Mask Options dialog.
Double-click the Array Mask tool. The following options window will open.

Select an odd number for the number of circles in 2 directions. On the screen, this will be shown as the first direction set (multiply) the next direction set.

Even after the number of circles has been set, it can be modified through this window. Set the number of pixels for the radius of the circles.

Even after the circle radius has been set, it can be modified through this window. After the direction and array width have been set, they can be changed as desired on the screen.

Decide whether the selected region (effective area) will be inside the circles or outside.

To modify direction or array width, drag either of the 2 green vectors.
2 Select Inverse FFT... from the Process menu.

![Inverse FFT Options dialog]

3 The following Inverse-FFT Options dialog will open.

In the above dialog, specify whether to display the Inverse-FFT image inside the image prior to applying FFT or to display it in the new window.

4 Click **IFFT** button. Inverse-FFT will be conducted.

### 4.6.4 Saving the FFT Image

When the check button is clicked for **Keep FFT image** in the following window -- which is displayed when Inverse FFT is being used -- and leaving it selected, Inverse FFT will be performed with the FFT image saved as it is.

![Inverse FFT Options dialog]

Note: This will not be possible if there is no available memory for saving the FFT image.
Eleven kinds of filters can be used.

<table>
<thead>
<tr>
<th>Process</th>
<th>Filter</th>
</tr>
</thead>
<tbody>
<tr>
<td>FFT...</td>
<td>Invert Pixel...</td>
</tr>
<tr>
<td></td>
<td>Hot/Cold Spot Filter...</td>
</tr>
<tr>
<td></td>
<td>Rotate...</td>
</tr>
<tr>
<td></td>
<td>Flip...</td>
</tr>
<tr>
<td></td>
<td>Joint...</td>
</tr>
<tr>
<td></td>
<td>Aspect Ratio...</td>
</tr>
<tr>
<td></td>
<td>Arithmetic...</td>
</tr>
<tr>
<td></td>
<td>Compose...</td>
</tr>
<tr>
<td></td>
<td>Contour Plot...</td>
</tr>
<tr>
<td></td>
<td>Averaging...</td>
</tr>
<tr>
<td></td>
<td>Medien...</td>
</tr>
<tr>
<td></td>
<td>Gradient...</td>
</tr>
<tr>
<td></td>
<td>Roberts...</td>
</tr>
<tr>
<td></td>
<td>Sobel...</td>
</tr>
<tr>
<td></td>
<td>Laplacian...</td>
</tr>
<tr>
<td></td>
<td>Prewitt...</td>
</tr>
<tr>
<td></td>
<td>Marr-Hildreth...</td>
</tr>
<tr>
<td></td>
<td>Sharp...</td>
</tr>
<tr>
<td></td>
<td>Unsharp Mask...</td>
</tr>
<tr>
<td></td>
<td>Custom...</td>
</tr>
<tr>
<td></td>
<td>Rotational...</td>
</tr>
</tbody>
</table>

Low-pass filters (low-frequency pass filters) are noise elimination and smoothing:
- Averaging
- Median

High-pass filters (high-frequency pass filters) are line and edge detection and image sharpness:
- Gradient
- Roberts
- Sobel
- Laplacian
- Prewitt
- Marr-Hildreth
- Sharp

Enhancing changes in the original image (automatic processing of the operation between images):
- Unsharpmask

Using a filter kernel that has been created as desired:
- Custom
1. Double-click the Image Selector tool in the tool window.

2. The following Marquee Options window will appear.

3. In the above window, select the method for enclosing the area with a frame.
   - **Free (Normal)**: While the Image Selector tool is moved on the screen, the number of pixels will be expressed arbitrarily. At this time, refer to the number of pixels for width and height specified in the Info. window.
   - **Fixed**: The number of pixels for width (W) and height (H) of the Image Selector tool will be fixed.
   - **$2^n$**: The Image Selector tool moved on the screen will automatically express the number of pixels as $2^n$.

4. Using the following procedure, conduct filter processing.
(a) Applying averaging

Using the set kernel size (pixel $\times$ pixel), the average value is sought and that value becomes the value for the point of focus. This processing is done for the specified area. Select Filter from the Process menu and then select Averaging from the submenu that appears. The following Averaging Options window will open.

Specify kernel size using odd numbers.

Kernel Size: $3 \times 3$

- Simple
- Gaussian

Show Result In
- Current Window
- New Window

When others... is selected, the following window will open.

Set kernel size using odd numbers in the horizontal and vertical directions. After setting, click the OK button. It is possible to set the size to up to 1/8th of the image domain that was selected.
Select the averaging type.

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple</td>
<td>Averaging will be done after assigning a coefficient of 1 to each pixel.</td>
</tr>
<tr>
<td>Gaussian</td>
<td>Averaging will be done after a weighted coefficient based on regular.</td>
</tr>
</tbody>
</table>

Select the window in which to display the image after processing.

<table>
<thead>
<tr>
<th>Show Result in</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Window</td>
<td>Displays image in the window it was displayed in</td>
</tr>
<tr>
<td>New Window</td>
<td>Displays image in a new window.</td>
</tr>
</tbody>
</table>

Click the **Filter** button and filtering will be performed.
(b) Applying Median

Arrange linearly the intensity of each pixel in the specified kernel size (pixel x pixel) and make the center value the value of the point of focus. This processing is done on the specified area. Select Filter from the Process menu and then select Median from the submenu that appears. The following Median Options window will open.

In the same way as for averaging, set kernel size and select the window that the image should be displayed in after processing and click the Filter button. Filtering will then be performed.

(c) Applying Gradient

Move in the x and y directions the kernels that have the following coefficients. Then, take the geometrical mean and conduct processing.

\[
\begin{array}{ccc}
X & & Y \\
0 & 0 & 0 & 0 & 0 & 0 \\
0 & 1 & -1 & 0 & 1 & 0 \\
0 & 0 & 0 & 0 & -1 & 0 \\
\end{array}
\]

Select Filter from the Process menu and then select Gradient from the submenu that appears. The following Gradient Options window will open.
Set the amplitude. The value input for the calculated value from filtering can be applied.

**Amplitude**: 1.0

Select an offset value. The value input for the calculated value from filtering can be applied.

**Offset**: 0

Select the effect type.

- **Emphasize**: The portion that has changed will be emphasized (Edge emphasis).
- **Detect**: Only the portion that has changed will be displayed (Edge emphasis).

Select the window the image should be displayed in after processing.

- **Current Window**: Displays image in the window it was displayed in prior to processing.
- **New Window**: Displays image in a new window.

When the **Filter** button is clicked, Filtering will be performed.
(d) Applying Roberts

Move in the x and y directions the kernels that have the following coefficients.
Then, take the geometrical mean and conduct processing.

\[
\begin{array}{ccc}
X & Y \\
0 & 0 & 0 \\
0 & 1 & 0 \\
0 & 0 & -1 \\
\end{array}
\]

Select Filter from the Process menu and then select Roberts from the submenu that appears.
The following Roberts Options window will appear.

As for Gradient, select the amplitude, offset value, effect type, and appropriate window; then, click the \textbf{Filter} button and filtering will be performed.
(e) Applying Sobel

Move in the x and y directions the kernels that have the following coefficients.

Then, take the geometrical mean and conduct processing.

\[
\begin{array}{ccc}
X & & Y \\
-1 & 0 & 1 & -1 & -2 & -1 \\
-2 & 0 & 2 & 0 & 0 & 0 \\
-1 & 0 & 1 & 1 & 2 & 1 \\
\end{array}
\]

Select Filter from the Process menu and then select Sobel from the submenu that appears.

The following Sobel Options window will open.

As for Gradient, select the amplitude, offset value, effect type, and appropriate window; then, click the Filter button and filtering will be performed.
(f) Applying Laplacian

Use one of the 3 types of kernels with the coefficients shown below.

<table>
<thead>
<tr>
<th>Type1</th>
<th>Type2</th>
<th>Type3</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 -1 0</td>
<td>-1 -1 -1</td>
<td>1 -2 1</td>
</tr>
<tr>
<td>-1 4 -1</td>
<td>-1 8 -1</td>
<td>-2 4 -2</td>
</tr>
<tr>
<td>0 -1 0</td>
<td>-1 -1 -1</td>
<td>1 -2 1</td>
</tr>
</tbody>
</table>

Select Filter from the Process menu and then select Laplacian from the submenu that appears. The following Laplacian Options window will open.

Select the operator type.

Operator

As for Gradient, select the amplitude, offset value, effect type, and appropriate window; then, click the filter button and filtering will be performed.
(g) Applying Prewitt

Conduct processing by using the 8 types of kernels with the following coefficients and the template matching method.

```
(1)  1  1  1  
   1 -2  1  
   -1 -1 -1  
(2)  1  1  1  
   1 -2 -1  
   1 -1 -1  
(3)  1  1  1  
   1  1 -1  
   1  2 -1  
(4)  1  1  1  
   1  2 -1  
   1  1  1  
(5)  -1 -1 -1  
   1 -2  1  
   1  1  1  
(6)  -1 -1 -1  
   -1 -2  1  
   -1  1  1  
(7)  -1 -1 -1  
   1 -2  1  
   -1  1  1  
(8)  -1  1  1  
   -1 -2  1  
   -1  1  1
```

Select Filter from the Process menu and then select Prewitt from the submenu that appears.
The following Prewitt Options window will open.

As for Gradient, select the amplitude, offset value, effect type, and appropriate window; then, click the Filter button and filtering will be performed.
With the Marr-Hildreth option, processing will be done with kernels for which the Laplacian option to has been applied to Gaussian distribution. These coefficients will derive various values based on the number of pixels in the kernels.

The following formula can be used to derive the original coefficient.

\[
\nabla^2 G(r) = \frac{1}{\pi \sigma^4} \left( \frac{r^2}{2 \sigma^2} - 1 \right) e^{\frac{-r^2}{2 \sigma^2}}
\]

Select Filter from the Process menu and then select Marr-Hildreth from the submenu that appears. The following Marr-Hildreth Options window will open.

Select the kernel size, amplitude, offset value, and appropriate window; then, click the Filter button and filtering will be performed.
(i) Applying Sharp Filter

With the Sharp Filter option, changes in the original image are enhanced by automatically subtracting unsharp image from the original image.

Select Filter from the Process menu and then select Sharp from the submenu that appears. The following Sharp Options window will open.

```
Kernel Size: 11 x 11 (px)
Amplitude: 1.0
Offset: 0

Show Result In
- Current Window
- New Window
```

Select the kernel size, amplitude, offset value and appropriate window, then click the Filter button and sharp filter will be applied.
With the Unsharpmask option, changes in the original image are enhanced through analysis of the original image +a (original image - unsharp image).

* a : Amplitude in the Unsharpmask Options window below.

Select Filter from the Process menu and then select Unsharpmask from the submenu that appears.
The following Unsharpmask Options window will open.

Select the kernel size, amplitude and appropriate windows, then click the **Filter** button and unsharp masking will be performed.
(k) Applying Custom

With Custom, a kernel with coefficients set arbitrarily by the operator is used for processing.
Select Filter from the Process menu and then select Custom from the submenu that appears.
The following Custom Matrix Kernels window will open.

```
Custom Matrix Kernels

Kernel Size: 3 x 3 (pix)
Scale: Offset: 0
Show Result in: Current Window

Click Filter and filtering will be performed with the created kernels.
Click Save... and the kernel will be saved (in text format).
Click Load... and it will be possible to call up the kernel.
```

As for averaging, set the kernel size.
Also, set the scale value.

Scale:

After processing, the value of the point of focus will be divided by the scale value.
Set the offset value, select the window, and input the coefficients in the grid of the kernel.
Click the Filter button and filtering will be performed with the created kernels.

Click Save... and the kernel will be saved (in text format).
Click Load... and it will be possible to call up the kernel.
4.6.6 Inverting the Image Data

Pixel values composed the image can be converted (inverted). For the FFT images and the Contour plot images, this function is not available. When the image data pixel is 16384 gray level (14 bit), each pixel will be converted as follows.

<table>
<thead>
<tr>
<th>Before converting</th>
<th>After converting</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>16384</td>
</tr>
<tr>
<td>1</td>
<td>16383</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>16383</td>
<td>1</td>
</tr>
<tr>
<td>16384</td>
<td>0</td>
</tr>
</tbody>
</table>

1. Open the target image. Specify the target region. (If you have not specified any region, all the region will be inverted.)

2. Select Invert... from the Process menu.

The following Invert Options window will open.
3. Select the window in which to display the image after processing.

   Show Result in
   - Current window
   - New window

4. Click the [Invert] button to invert the image (region).

4.6.7 Filtering the Hot / Cold Spot

When white/black spots appear on the read image causing the detector's pixel failure, you can remove (filter) them using this function.

1. Open the target image and specify the target region. (If you have not specified any region, all the region will be filtered.)

2. Select Hot/Cold Spot Filter... from Process menu.

   The following Hot/Cold Spot Filter window will open.

   Filtering Constant: 1000

   - Show Result in
     - Current window
     - New window

   [Cancel] [Filter]
3 Input the filtering constant.

Filtering Constant: 1.000

If the spots is in higher level (Hot spot), first the difference \( a \) between the target pixel and the maximum pixel around the target pixel is obtained, then \( a \) and the difference between maximum pixel and minimum pixel around the target pixel will be compared. If 
"10" is input as a constant, the target pixels (spots) will be removed when \( a > (b) 10 \) is satisfied.

4 Select the window in which to display the image after processing.

Show Result in

- Current Window
- New Window

5 Click button to execute this function.

Example of Effect

![Before and After](image.png)
4.6.8 Rotate Function

1. Using the Image Selector tool in the tool window, set the area to be rotated.
   (If no area is set, the entire image will be rotated.)

2. Select Rotate... from the Process menu.

   ![Process Menu](image)

   The following Rotate Options window will open.

   ![Rotate Options Window](image)

   Set the angle of rotation.

   \[
   \text{Angle} : 90.000 \text{ (degree)} \]

   Set the display magnification to follow rotation.

   \[
   \text{Mag} : 1.000 \text{ (0.1 ... 10.0)}
   \]
Set the direction of rotation.

<table>
<thead>
<tr>
<th>Direction</th>
</tr>
</thead>
<tbody>
<tr>
<td>CW</td>
</tr>
<tr>
<td>CCW</td>
</tr>
</tbody>
</table>

CW  Rotation will be clockwise.
CCW  Rotation will be counterclockwise.

Select the image interpolation method to follow rotation.
(Interpolation will be done on the pixel of the non-lattice point following rotation.)

<table>
<thead>
<tr>
<th>Interpolation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nearest Neighbor</td>
</tr>
<tr>
<td>Bi-Linear</td>
</tr>
<tr>
<td>Bi-Cubic</td>
</tr>
</tbody>
</table>

Nearest neighbor: The density of the lattice point for the uv coordinates closest to the non-lattice point \((u_0, v_0)\) will be set as the value for \((u_0, v_0)\).

Bi-linear: Using the densities of 4 lattice points around the non-lattice point \((u_0, v_0)\), the density for \((u_0, v_0)\) is interpolated linearly.

\[
f(u_0, v_0) = f(u', v')(1 - a)(1 - B) + f(u' + 1, v') a(1 - B) + f(u', v' + 1)(1 - a) B + f(u' + 1, v' + 1) a B
\]

\[
u' = (u_0), \quad v' = (v_0), \quad a = u_0 - (u_0), \quad B = v_0 - (v_0),
\]

\((w)\) expresses the maximum integer that does not exceed \(w\).

Bi-cubic: Using the densities of 16 lattice points around \((u_0, v_0)\), cubic interpolation is done.

\[
f(u_0, v_0) = \sum_k \sum_i f(u_k, v_l) \in (u_0 - u_0) \in (v_0 - v_0)
\]

Here \((u_k, v_l)\) is a lattice point around \((u_0, v_0)\) and interpolative coefficient \(c(x)\) is defined linearly.

\[
c(x) = \begin{cases} 
1 - 2|x|^2 + |x|^4 & 0 \leq |x| < 1 \\
4 - 8|x|^2 + 5|x|^4 & 1 \leq |x| < 2 \\
0 & 2 \leq |x|
\end{cases}
\]

Function \(c(x)\) is piecewise three-dimension polynomial approximation of function \(\sin x / x\) that is revealed with the sampling theorem for continuous signals.
Select the window the image should be displayed in after processing. Also, activate (check) "Clip to source area size."

3 Click the [Rotate] button to conduct rotation.

When Clip... has not been checked.

When Clip... has been checked.
The result of the last angle measured when image rotation functions were used will be set as the default value for the rotation angle for image rotation.

From the above example, 40.696 degree will be set as the default for "Angle."
4.6.9 Flip Function

1. Using the Image Selector tool in the tool window, define the area to be flipped.
   (If no region is defined, the entire area will be flipped.)

2. Select Flip... from the Process menu.

The following Flip Options window will open.
Select the direction of flipping.

**Direction**
- Horizontal
- Vertical

Horizontal Area will be flipped horizontally.
Vertical Area will be flipped vertically.

Select the window the image should be displayed in after processing.

**Show Result in**
- Current window
- New window

3. Click the **Flip** button and flipping will be done.
4.6.10 Joint Function

1. Open the entire image that you want to attach.
   * Only image of the same size and density resolution can be attached.

2. Select Joint... from the Process menu.

   The following Joint Options window will open.

   ![Joint Options Window]

   Select the direction in which you want to attach the image.

   ![Direction Options]

   Horizontal  Image will be attached horizontally.
   Vertical    Image will be attached vertically.
Select the image that you want to joint.

Image A: HNB2005_1024.img

Image B: AU5.img

Selection can be made from the pulldown menu.

<table>
<thead>
<tr>
<th>Image A</th>
<th>Image B</th>
</tr>
</thead>
<tbody>
<tr>
<td>HNB2005_1024.jpg</td>
<td>GaAs512_0RG.jpg</td>
</tr>
<tr>
<td>AU5.jpg</td>
<td>CBED4.jpg Export</td>
</tr>
</tbody>
</table>

3 Click the Joint button to joint the image.
4.6.11 Modifying the Image Aspect Ratio

This function is used to modify an image's vertical-to-horizontal ratio. It is effective for correcting distortion and the like in images obtained from external detection devices.

1. Select the image domain for processing and then select Aspect Ratio... from the Process menu. The following Aspect Ratio Options dialog will be displayed.

![Aspect Ratio Options dialog](image)

- **Original Size:**
  - X: 512
  - Y: 512

- **Converted Size:**
  - X: 512
  - Y: 512

- **Interpolation**
  - Nearest Neighbor
  - Bi-Linear
  - Bi-Cubic

Options:
- [Cancel]
- [Process]
Original Size: Original size of the select domain (unit: pixels).

Converted Size: Input the desired post-modification size (unit: pixel).

Interpolation: Select the type of interpolation desired at time of modification.

Nearest Neighbor: Sets the density for the lattice point of the uv coordinates that are closest to non-lattice point \((u_o, v_o)\) as the value for \((u_0, v_0)\).

Bi-Linear: Using the densities of the 4 lattice points surrounding non-lattice point \((u_o, v_o)\), the density of \((u_0, v_0)\) is interpolated via the following formula.

\[
f(u_0, v_0) = f(u', v')(1-a)(1-b) + f(u'+1, v')a(1-b) + f(u', v'+1)(1-a)b + f(u'+1, v'+1)ab\]

\(u' = (u_0), v' = (v_0), a = u_o - (u_0), b = v_o - (v_0),\)

(w) expresses the maximum integer, which will not exceed w.

Bi-Cubic: Using the densities of the 16 lattice points surrounding \((u_o, v_o)\), 3-dimensional interpolation is done.

\[
\hat{f}(u_o, v_o) = \sum \sum f(u_k, v_l)\hat{c}(u - u_k)\hat{c}(v - v_l)
\]

Here, \((u_k, v_l)\) is a lattice point surrounding \((u_o, v_o)\).

Interpolation coefficient \(c(x)\) is defined with the following formula.

\[
c(x) = \begin{cases} 
1 - 2|d|^2 + |d|^3 & 0 \leq |d| < 1 \\
4 - 8|d| + 5|d|^2 - |d|^3 & 1 \leq |d| < 2 \\
0 & 2 \leq |d|
\end{cases}
\]

Function \(c(x)\) is a divided 3-dimensional polynomial expression approximation of function \(\sin x / x\), which appears in continuous signal sample processing.

2 Click to implement.
4.6.12 Using Arithmetic

1. Open the entire image you want to use arithmetic on.
   * Intra-image arithmetic can only be performed on images of the same size and density resolution.

2. Select Arithmetic... from the Process menu.

The following Arithmetic Options window will open.

Select the desired type of arithmetic.
A+B: Addition, A-B: Subtraction, AxB: Multiplication, A/B: Division
AxA/B: Multiplication and division done at one time
A+const: Add a constant, A-const: Subtract a constant,
Aconst: Multiply by a constant, A/const: Divide by a constant,
sqrt(A) x const: Take the root and multiply by a constant,
log(A) x const: Take the logarithm and multiply by a constant.

Input the offset value (the pixel (QL) value to be added to image data after processing).

Offset : 0

Input the amplitude for the image and image data on which arithmetic was done.

Image A : HNB205_1024.img ▼ x 1.0
Image B : CBED4.img.Export ▼ x 1.0

The image to undergo arithmetic can be selected from the pulldown menu.

Image A : HNB205_1024.img ▼ x 1.0
Image B : GsAs512_ORG8.1mg ▼ x 1.0

When performing arithmetic that involves a constant, input a value for the constant.

Constant : 1.000000 (-1000000.0 ... +1000000.0 : Real number)
Select the data type to be used in the arithmetic.

<table>
<thead>
<tr>
<th>Data Type</th>
<th>QL (Pixel Data)</th>
<th>AU (Converted Data)</th>
</tr>
</thead>
</table>

QL: Arithmetic done with QL (pixel) value.
AU: Arithmetic done with linear value.

* The AU portion will display the unit of the image being handled.

Select whether to align the position between images or not. If the position alignment function is selected, specify either of the following options.

<table>
<thead>
<tr>
<th>Position Matching Type</th>
<th>None</th>
<th>Manual</th>
<th>Spot mark</th>
<th>Line mark</th>
</tr>
</thead>
</table>

None: Position alignment not performed.
Manual: Manually performed position alignment by checking overlapped images on the mirror.
Spot mark: Semi-automatic position alignment using the Markspot tool.
Line mark: Semi-automatic position alignment using the Markline tool.

Select when using the function for aligning the position between two images on which the Markspot tool and the Markline tool have been used.

Select the window to show the results of arithmetic in.

<table>
<thead>
<tr>
<th>Show Result in</th>
<th>New Window</th>
<th>Image A Window</th>
<th>Image B Window</th>
</tr>
</thead>
</table>

New Window: Results will be displayed in a new window.
Image A Window: Results will be displayed in one of the image windows (A) used in the arithmetic.
Image B Window: Results will be displayed in one of the image windows (B) used in the arithmetic.

3 Click the Calc button to perform arithmetic.
4.6.13 Manually Aligning the Image Position

With the function, image position can be manually aligned viewing an image overlapped with another.

1 Open the image you want to use arithmetic on.

* The "image" above implies the image other than Contour Plot on FFT images.

2 Select Arithmetic... from the Process menu.

3 Specify several items in the Arithmetic Options dialog and select Manual from the Position Matching Type.

4 Clicking the Calc button will display the matching dialog shown on next page.
On this dialog, Image A is displayed overlapped with Image B.

Clicking the Calc button will perform arithmetic.

Image B that overlaps Image A can be moved by dragging. If angle adjustment is required, enter the rotation angle and clockwise and counterclockwise rotation. Overlapping Image B will then rotate.

4 If the Detail button is clicked, the image will be displayed enlarged as follows.

Clicking the Calc button will perform arithmetic.
4.6.14 Semi-automatically Aligning the Image Position

This function is for semi-automatic overlapping of the space between two images (of the same sample) for intra-image arithmetic. The Markspot tool and Markline tool can be used.

Markspot tool: Aligns the position between two images.
Markline tool: Aligns the position/angle between two images.

(a) Markspot tool

1. Open the images for intra-image calculation.
   * This means to open any but a Contour Plot or FFT image.

2. Using the Markspot tool, specify the portion that will serve as the standard for image overlapping.

   1) Double-click the Markspot tool on the Tool window. The following dialog will be displayed.
Here, select Markspot Area Size.

Markspot Area Size: At time of overlapping, a rectangle is created using Markspot as the center, and intra-image overlapping is done via relative calculation from within that area. Markspot Area Size indicates the size of the rectangle used at that time.

- Small: Creates a rectangle with 200 pixels on 1 side.
- Medium: Creates a rectangle with 400 pixels on 1 side.
- Large: Creates a rectangle with 600 pixels on 1 side.

2) After Mark Spot Area Size has been selected, place the Markspot on the portion that will serve as the standard for overlapping the area between two images (that is, on a portion that is common to both images).
3) For the image that corresponds to the head of the left side of the image arithmetic formula (for A - B, it would be image A, for example), use the Enclosure tool from the Tool window to specify the area between the images that you wish to calculate.

* The Markspot does not need to be within the area to be calculated.
* For the image that corresponds to the head of the right side of the image arithmetic formula (for A - B, it would be image B, for example), after relative calculation of the space between two images, the calculated area will be automatically set.
* If no area has been specified, the entire area will be subjected to calculation.
4) Select **Arithmetic**... from the Process menu.

The following Arithmetic Options dialog will be displayed.

4.6.14 Semi-automatically Aligning the Image Position

Position Matching Type:
Select Spot mark.
Auto Adjust:
On: Performs position alignment using relative calculation.
Off: Performs position alignment between two images using Markspot position and without performing relative calculation.

5) Click **Calc** here to perform intra-image arithmetic using position alignment with the Markspot tool.
1. Open the images for intra-image calculation.
   * The images referred to here are those other than Contour Plot and FFT images.

2. Using the Markline tool, set a portion that will serve as the standard for total-image overlapping.

   1) Double-click the Markline tool in the Tool window. The following dialog will be displayed.

   ![Markline tool window]

   Select Markline Area Size here.

   Markline Area Size: At time of overlapping, a rectangle is created focusing on Markline's starting point and ending point. In that region, with relative calculation, intra-image overlapping is done. Sizes of the rectangles created are defined as follows:

   Small: Creates a rectangle with 200 pixels on one side.
   Medium: Creates a rectangle with 400 pixels on one side.
   Large: Creates a rectangle with 600 pixels on one side.
2) After selecting Markline Area Size, create the Markline using 2 points (Markline's starting point and ending point) from the portion that serves as the standard for 2-image overlapping (the area between the two images that is jointly shared).

Place the Markspot on the portion that serves as the standard for 2-image overlapping.
3) For the image that corresponds to the head of the left side of the image arithmetic formula (for A-B, it would be image A, for example), use the Enclosure tool from the Tool window to specify the area between images that you wish to calculate.

* The Markline does not need to be within the area calculated.
* For the image that corresponds to the head of the right side of the image arithmetic formula (for A-B, it would be image B, for example), after relative calculation of the space between two images, the calculated area will be automatically set.
* If no area has been specified, the entire area will be subjected to calculation.
4) Select Arithmetic... from the Process menu.

The following Arithmetic Options dialog will be displayed.

**Operation:** A - B

**Offset:**

**Image A:**
- testraw
- 1.000000

**Image B:**
- testraw2
- 1.000000

**Constant:**

**Date Type:**
- DL (User Data)
- AU (Converted Data)

**Position Matching Type:**
- Line mark

**Auto Adjust:**
- On
- Off

**Show Result In:**
- New Window

*Final value can overflow or underflow by the settings of parameters such as offset, coefficients of A&B, constant.*

**Position Matching Type:**
- Select Line mark.

**Auto Adjust:**
- Off: Performs position/angle alignment between two images using Markline position as the standard and without performing relative calculation.

5) Click **Calc** here to perform intra-image arithmetic after position/angle alignment using the Markline tool.
When there is pixel overflow or underflow for each type of filter or intra-image arithmetic result, a dialog like the following will be displayed.

NOTE! The new image has some overflowed or underflowed pixels.

overflow: 5 pixels (out of 11260000 pixels)
underflow: 24618 pixels (out of 11260000 pixels)
4.6.16 Displaying the Composed Fluorescent Image

1. Open the image you want to display composed. Display each image in fluorescent colors.

2. Select Compose from the Process menu.

3. In the Compose Options dialog, select the image you want to display composed.
   * Image A and B must be displayed in different fluorescent colors.

4. Clicking the [Select] button will display the Compose dialog shown on the next page.
On this dialog, Image A is displayed overlapped with Image B.

Clicking the **Compose** button will perform image composition.

Image B that overlaps Image A can be moved by dragging. If angle adjustment is required, enter the rotation angle and click **Clockwise** and **Counterclockwise**. Overlapping Image B will then rotate.

4. If the **Detail** button is clicked, the image will be displayed enlarged as follows.

* Images that have been subjected to image composition cannot be stored. Any image processing is also not possible. Image export to the TIFF file is possible.

- **PICT file**: Export at display resolution
- **TIFF file**: Export at display resolution
4.6.17 Displaying the Contour Line

1. Using the Image Selector tool in the tool window, set the area for which you want to display the contour line.

2. Select Contour Plot... from the Process menu.

The following Contour Plot Options window will be displayed.
Select the unit in which the contour line should be displayed.

QL (Quantum Level) → Logarithm unit

cnt (count) → Linear unit (shows the number of electrons).

However, for an image on which the following intra-image arithmetic is done, the unit will change from cnt to AU.

$A \times B$ : multiplication, $A / B$ : division, $\sqrt[3]{A}$ : deribing the root,

$log(A)$ : taking the logarithm.

**Data Type :**

- $\bigcirc$ QL
- $\bigcirc$ cnt

Set the number of lines for the contour line, up to a maximum of 16.

**Number of lines :** 6

The number of lines can be set from the pulldown menu.

At first, the triangle marker will overlap the setting for number of lines, as shown below.
Drag the triangle marker to the desired position. At this time, the value for the triangle marker will be shown within the Value box in terms of the specified unit (here, QL).

After setting the maximum and minimum values for the contour line, click the \textbf{Equalize} button. The space between the maximum and minimum values will be divided uniformly with the selected number of contour lines. (In this example, 4 contour lines were used.)

If an arbitrary value is input for Value, the triangle marker will move to the position of the input value.

Select the display color for the contour line.

- \textbf{B/W} Black and white display.
- \textbf{Color} Color display.

3 Click the \textbf{Plot} button and the contour line will be made.
4.7 Displaying Multiple Images

When multiple images have been opened, the following 2 display methods can be used.
(a) Cascade  Images are displayed in staggered form.
(b) Tile  Images are displayed lined up like tiles.

(a) Cascade

1. Select Cascade from the Window menu.

The display will be something like the following.
(b) Tile

1. Select Tile from the Window menu.

![Window menu with Tile selected]

The display will be something like the following.

![Multiple images displayed in Tile view]
4.8 Saving

The following 3 methods can be used for saving.

(a) Save  The overwritten or already processed (involving changes in the pixel value) image will be newly saved.

(b) Save as  Saves image data in another name.

(c) Export  A portion of the image is clipped out and saved in another format.

(a) Save

1 Select Save... from the File menu.

File

Open...  
Import...

Close  
Save...

Save as...

Specify the destination for saving in the open dialog.

(b) Save as

1 Select Save as... from the File menu.

File

Open...  
Import...

Close  
Save...

Save as...

Input the filename and specify the destination for saving in the open dialog.
(c) Export

1. Select Export from the File menu and specify file type from the submenu of the File menu.

    File
    Open... 360
    Import...
    Close 36W
    Save... 36S
    Export
    Revert

PICT... : Exports an image to PICT file with the number of pixels on the monitor.
TIFF... : When a TIFF file is selected, the following dialog will appear.

```
Export TIFF

Image resolution to save:

- Window
- Original(8bit)
- Original(16bit)

Cancel
```

Window... : Converts conditions actually displayed on the Window to the TIFF file (palette color TIFF) according to pixel size on the monitor.
Original(8bit)... : Converts to 8bit-grey TIFF file without thinning out the pixel size from original image. If it is the 2byte-data, decreases gradation to the upper/lower limit-value on Range Scope.
Original(16bit)... : Converts 2byte-data to 16bit-grey TIFF file without thinning out the pixel size from the original image. For 8bit data, this function cannot be selected.

Raw... : Exports an image to raw image.

2. The following dialog will be displayed. Set the Export destination and then click Save.
3. When exporting an image of density resolution of 8 bits or more in RAW format, the following Raw Export Options dialog will be displayed.

![Raw Export Options dialog]

4. Click ☐ Original Depth (14-bit) or ☐ 8-bit Depth (selected in Rangescope) and then click OK to implement.

(The 8-bit depth will be used for the histogram domain selected with Rangescope.)
4.9 Undoing Processing

This function can be used to undo the previous process.

1. Select Undo from the Edit menu.

   Edit
   Undo  ⌘Z

   The previous process will be undone.

   * Undo can only be used to undo the previous process when no other method is available.

   For example, in magnification processing, Undo cannot be used because reduction processing can be used to fulfill the same function.

To reverse all image processing and restore the image to its original state, select Revert from the File menu.

   File
   Open...  ⌘O
   Import...
   Close  ⌘W
   Save...  ⌘S
   Save as...
   Export
   Revert

   The original image will be restored.
4.10 Viewing Image Information

1. Select File Info... from the File menu.

The following File Information screen will open.

<table>
<thead>
<tr>
<th>Filename</th>
<th>: 000024-9501.jpg</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header</td>
<td>: FILE5000..SCAN..FILE</td>
</tr>
<tr>
<td>Original Name</td>
<td>: 000024-9501</td>
</tr>
<tr>
<td>IP Type</td>
<td>: FDL-UR-V</td>
</tr>
<tr>
<td>Pixel Size</td>
<td>: 25</td>
</tr>
<tr>
<td>Pixel Depth</td>
<td>: 14</td>
</tr>
<tr>
<td>Pixel Number</td>
<td>: 8760</td>
</tr>
<tr>
<td>Raster Number</td>
<td>: 5000</td>
</tr>
<tr>
<td>Sensitivity</td>
<td>: 0.000</td>
</tr>
<tr>
<td>Latitude</td>
<td>: 4</td>
</tr>
<tr>
<td>Date &amp; Time</td>
<td>: Tue Jan 3 15:57:24 1995</td>
</tr>
<tr>
<td>Comment</td>
<td>: sample</td>
</tr>
</tbody>
</table>

| Magnification  | : 100K            |
| File No.       | : 801234          |
| Camera length  | : 001.0cm         |
| Date of Exposure| : 19940501120000  |
| Date          | : 20E-15/2.0E-09   |
| Dose coeff.    | : 3000            |
| Print Range    | : 00000/12385      |
| Exposure Status| : 9006            |
| Specimen       | : 0935            |
| Specimen Angle | : X35000/12000/200450 |
| User Name      | : kobayasi        |
| Microscope     | : TEM-12           |
| Total Scanned IPc | : 0000024        |
| PR Rental No.  | : 4692400         |
| No. of Stored Image | : 001        |

To close this window, click inside it.
4.11 Printing

4.11.1 Printing Image on Laser Beam Printer

1. Activate the window of the image that you wish to print.

2. Select Page Setup... from the File menu and select paper settings.

3. Select Print... from the File menu to print.
4.11.2 Easily Printing Images Out on Pictrography 3000, 3500, 4000 or PSD400

1. Activate the window of the image that you wish to print.

2. Select Print Pictro... from the File menu.

3. The following dialog will be displayed.

![Print dialog](image)
Window: Displays the name shown in the window header of the image targeted for printing.
This name will be printed out as additional information on the bottom left of the printing paper, in black.
Printing position will be as follows. (Character size is fixed.)

* The arrows indicate the direction of the top of the image on CRT display.

Image Size: Displays the size of the image targeted for printing.

Print Type:
1:1 pixel (Display Mag.)
Prints images using the image display magnification ratio.
* The size will change depending on the image display magnification ratio effective at the time (which will be displayed in parentheses at the end of the image name).
1 : 1  -> Prints with 1 pixel of image data corresponding to 1 pixel on Pictrography.
1 : 2  -> Prints with 2x2 pixels of image data corresponding to 1 pixel on Pictrography.
2 : 1  -> Prints with 1 pixel of image data corresponding to 2x2 pixels on Pictrography.
* The size of the image to be printed out will differ with the image display magnification ratio. Thus, select the image magnification ratio prior to printing.

Example: When display magnification ratio of 1:1 and paper size "A4" are selected for an image of 3000x3760 pixels, the image will be printed out so that it takes up nearly the entire surface of the paper.

1:1 image
Prints free-size images. The width and height can be finely adjusted using the Adjust Width/Adjust Height option.

Paper Size: Indicates the size of paper used for printing out the image.

* The paper size differs depending on the printer that is connected. In the case of PG4000 or PSD400, the paper size is automatically determined by the width of the paper being loaded.
4 After selecting Paper Size, click Print.

5 The following dialog will be displayed and the sending of data to Pictrography will begin.

* When the size of the image targeted for printing is larger than the size of the paper, a warning dialog like the following will be displayed, and only the area of the image that will fit inside the paper from the center out will be printed.
4.12 Starting Up Other Software

1. Select New Entry from the Application menu and select the software you want to enter.

![Application New Entry](image)

After you have done so, you can start up other software from the Application menu, as shown next.

![Application New Entry](image)

Canvas™ 3.5.1

When the Application menu is used to start up other software, the following Launch Options window will open.

![Launch Options](image)

Application: Canvas™ 3.5.1

Window: CRED4 img.Export (1:1)

Save File Type:
- [ ] None
- [ ] Fuji
- [ ] Raw
- [ ] PICT
- [ ] TIFF

- [ ] Quit 'L Process' to launch

- [ ] Launch Only
- [ ] Release from list
- [ ] Cancel

Release from list releases the currently entered software from the list.
Launch Only starts up the entered software without saving the current image. **Used when None (no saving) is selected under Save File Type.
When other than None is selected under Save File Type:
- [ ] Launch Only will change to [ ] Save & Launch

Save & Launch saves the current image (file format used for saving is selected from the window) and starts up the entered software.

When [ ] Quit 'L Process' to Launch is selected, the entered software will be started up after 'L Process' is quit.